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1 HP Deskjet F4200 All-in-
One series Help

For information about the HP All-in-One, see:

e HP All-in-One overview

e Find more information

e HowdolI?

e Connection information

e Load originals and load paper
e Print from your computer

» Use the copy features

» Use the scan features

e Maintain the HP All-in-One
»  Shop for ink supplies

e HP warranty and support

e Technical information

B NOTE: Ifyou are using the product with a Windows 2000 computer, some features
may not be available. For more information, see Notice to Windows 2000 users.
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2 HP All-in-One overview

The HP Deskjet F4200 All-in-One series is a versatile device that enables easy-to-use
copying, scanning, and printing.
Copy

The HP All-in-One allows you to produce high-quality color and black-and-white copies
on a variety of paper types. You can enlarge or reduce the size of an original to fit a
specific paper size, adjust the copy quality, and make high-quality copies of photos.

Scan

Scanning is the process of converting text and pictures into an electronic format for your
computer. You can scan almost anything (photos, magazine articles, and text documents)
on the HP All-in-One.

Print from your computer

The HP All-in-One can be used with any software application that allows printing. You
can print a range of projects, such as borderless images, newsletters, greeting cards,
iron-on transfers, and posters.

This section contains the following topics:
e The HP All-in-One at a glance

* Control panel buttons

e Status light overview

e Use the HP Photosmart software

The HP All-in-One at a glance
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Label Description

Control panel

Front access door

Paper-width guide

Input tray

Tray extender

Print cartridge door

Glass

Lid backing

© | 0| N o | 0|~ w N |k

Rear access door

=
o

Rear USB port

Power connection”
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[

*

Use only with the power adapter supplied by HP.

Control panel buttons
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Label

Icon

Name and Description

Ink Level lights: Show ink level information for each print cartridge, four for
the tri-color cartridge and four for the black cartridge.

Check Print Cartridge lights: Indicates the need to reinsert the specified print
cartridge, replace the print cartridge, or close the print cartridge door. The
Black light indicates that the problem is with the black print cartridge, and
the Color light indicates that the problem is with the tri-color print cartridge.

Scan: Starts scanning the original currently on the glass. A Scan button
press is ignored if the HP All-in-One is busy with any other job. The Scan
button functions only when the computer is on.

Paper Selection: Changes the paper type setting to either plain or photo
paper. Make sure the appropriate paper type is loaded in the input tray. The
default paper type setting is Plain.

The Paper Selection lights indicate the currently selected paper size and
type:

» Plain: Letter and A4 paper

» Photo (Large): Letter and A4 photo paper

+ Photo (Small): 10 x 15 cm (4 x 6 inch), A6, or L photo paper

Enlarge/Fit to Page: Scales the original to the maximum size to fit within the
margins of the selected paper size for copying.

OlE

Start Copy Black: Starts a black-and-white copy job.

Press this button multiple times to specify multiple black copies. The printer
will start printing shortly after the number of copies have been selected. The
number of copies to be printed is shown to the right of this button.

TIP:  The maximum number of copies you can make using the control panel
is 9 (varies by model). To make more copies at once, use the HP Software.
When initiating multiple copies of an original from the software, only the last
digit of the number of copies is represented on the control panel. For

example, if you are making 25 copies, the number 5 appears on the display.

Start Copy Color: Starts a color copy job.

Press this button multiple times to specify multiple color copies. The printer
will start printing shortly after the number of copies have been selected. The
number of copies to be printed is shown to the right of this button.

TIP:  The maximum number of copies you can make using the control panel
is 9 (varies by model). To make more copies at once, use the HP Software.
When initiating multiple copies of an original from the software, only the last
digit of the number of copies is represented on the control panel. For

example, if you are making 25 copies, the number 5 appears on the display.

Resume: Instructs the HP All-in-One to continue after a problem is solved.

A blinking Resume light next to the Resume button indicates the need to
load paper or clear a paper jam.

Cancel: Stops a print, copy, or scan job.

On: Turns the HP All-in-One on or off. The On button is lit when the HP All-
in-One is powered on. The light blinks while performing a job.

Control panel buttons 11

2
2
2
5]
>
o
o
jo
Q
i
<
(oL,
I




T
Y
pd
5
o
]
o
o
<
@
=
@
2

Chapter 2
(continued)

Label Icon Name and Description

When the HP All-in-One is off, a minimal amount of power is still used by the
product. To completely disconnect the power supply to the HP All-in-One,
turn the product off, and then unplug the power cord.

CAUTION: Before you unplug the power cord, you must press the On
button and allow the HP All-in-One to turn itself off. This prevents the print
cartridges from drying out.

Status light overview

Several indicator lights inform you of the status of the HP All-in-One.

Label Description

1 Ink Level lights

2 Check Print Cartridge lights

3 Paper Selection lights (for the Paper Selection
button)

4 Enlarge/Fit to Page light

5 Resume light

6 On light

12 HP All-in-One overview



The following table describes common situations and explains what the lights mean.

Light status

What it means

All lights are off.

The HP All-in-One is turned off. Press the On button to turn on the
product.

The On light and one of the Paper
Selection lights are on.

The HP All-in-One is ready for printing, scanning, or copying.

The On light is blinking.

The HP All-in-One is busy printing, scanning, copying, or aligning the
print cartridges.

The On light blinks quickly for 3
seconds and then is on steady.

You pressed a button while the HP All-in-One is already busy printing,
scanning, copying, or aligning the print cartridges.

The On light blinks for 20 seconds
and then is steady.

You pressed the Scan button and there was no response from the
computer.

The Resume light is blinking.

»  The HP All-in-One is out of paper.
e The HP All-in-One has a paper jam.

The Check Print Cartridge light is
blinking.

»  The print cartridge door is open.

»  The print cartridges are missing or not seated correctly.

»  The tape was not removed from the print cartridge.

»  The print cartridge is not intended for use in this HP All-in-One.
»  The print cartridge might be defective.

The On, Resume, and Check Print
Cartridge lights are blinking.

Scanner failure. For more information, see Scan fails.

Turn off the HP All-in-One, then turn it on again. If the problem persists,
contact HP Support.

NOTE: HP All-in-One will still operate as a printer.

All lights are blinking.

The HP All-in-One has a fatal error.

1. Turn off the product.

2. Unplug the power cord.

3. Wait a minute, then plug the power cord back in.
4. Turn on the product.

If the problem persists, contact HP Support.

Use the HP Photosmart software

2
9
=
o
>
o
)
=
Q
i
<
[a
I

The HP Photosmart Software provides a fast and easy way to make prints of your photos.
It also provides access to other basic HP imaging software features, such as saving and

viewing your photos.

For more information on using the HP Photosmart Software:

* Check the Contents panel on the left. Look for the HP Photosmart Software Help
contents book at the top.

« Ifyou do not see the HP Photosmart Software Help contents book at the top of the
Contents panel, access the software help through the HP Solution Center.

Use the HP Photosmart software 13
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B NOTE: The HP Photosmart software supports the following file formats: BMP, DCX,
FPX, GIF, JPG, PCD, PCX, TIF, PICT, PSD, PCS, EPS, TGA, SGI, PDF, and PNG
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3 Find more information

You can access a variety of resources, both printed and onscreen, that provide
information about setting up and using the HP All-in-One.

Setup Guide

The Setup Guide provides instructions for setting up the HP All-in-One and
installing software. Make sure you follow the steps in the Setup Guide in order.

If you have problems during setup, check the Setup Guide for troubleshooting
information, or see Troubleshooting in this onscreen Help.

Basics Guide

The Basics Guide contains an overview of the HP All-in-One, including step-
by-step instructions for basic tasks, troubleshooting tips, and technical
information.

HP Photosmart animations

The HP Photosmart animations, located in the relevant sections of the onscreen
Help, show you how to complete key tasks on the HP All-in-One. You will learn
how to load paper and other media, replace the print cartridges, and scan
originals.

Onscreen Help

The onscreen Help provides detailed instructions on using all features of the
HP All-in-One.

»  The How Do I? topic provides links so you can quickly find information on
performing common tasks.

»  The The HP All-in-One overview topic provides general information about
the main features of the HP All-in-One.

* The Troubleshooting topic provides information about resolving errors
you might encounter with the HP All-in-One.

Readme

The Readme file contains the most recent information which might not be found
in other publications.

Install the software to access the Readme file. For more information, see View

the Readme file.

www.hp.com/support

If you have Internet access, you can get help and support from the HP Web
site. This Web site offers technical support, drivers, supplies, and ordering
information.

Find more information 15
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How do I?

This section contains links to commonly performed tasks, such as printing photos and
optimizing your print jobs.

How do | change the print settings?
How do | print borderless photos on 10 x 15 cm (4 x 6 inch) paper?
How do | load envelopes?

How do | scan using the control panel?

How do | get the best print quality?

How do | print on both sides of the paper?

How do | replace the print cartridges?

How do | align the print cartridges?

How do | clear a paper jam?

How do I? 17
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5 Connection information

The HP All-in-One comes equipped with a USB port so you can connect directly to a
computer using a USB cable. You can also share the product over an existing home

network.

This section contains the following topics:

» Supported connection types

e Use printer sharing

Supported connection types

The following table contains a list of supported connection types.

Description

Recommended number
of connected
computers for best
performance

Supported software
features

Setup instructions

USB connection

One computer connected
with a USB cable to the
rear USB 2.0 high-speed
peripheral connection
port on the HP All-in-One.

All features are
supported.

Follow the Setup Guide
for detailed instructions.

Printer sharing

Up to five.

The host computer must
be on at all times in order
to print from the other
computers.

All features resident on
the host computer are
supported. Only printing
is supported from the
other computers.

Follow the instructions in

Use printer sharing.
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Use printer sharing

If your computer is on a network, and another computer on the network has an HP All-
in-One connected to it by a USB cable, you can print to that printer using printer sharing.

The computer directly connected to the HP All-in-One acts as the host for the printer and
has full software functionality. The other computer, which is referred to as a client, has
access only to the print features. You must perform other functions from the host
computer or from the control panel on the HP All-in-One.

To enable printer sharing on a Windows computer
A Refer to the user guide that came with your computer or see the Windows onscreen

Help.

Connection information
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6 Load originals and load paper

You can load many different types and sizes of paper in the HP All-in-One, including letter
or A4 paper, photo paper, transparencies, business cards, and envelopes.

This section contains the following topics:

e Load originals

e Choose papers for printing and copying
* Load paper

Load originals

You can copy or scan business cards, photo paper, letter- or A4-size originals by loading
them on the glass.

To load an original on the glass
1. Lift the lid to the open position.
2. Load your original print side down on the right front corner of the glass.

-{} TIP: For more help on loading an original, see the engraved guide below the
glass.

TIP: To getthe correct copy size, make sure that there is no tape or other foreign
object on the glass. For more information on copy sizes and layouts, see Choose

a layout.
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3. Close the lid.
Choose papers for printing and copying
You can use different types and sizes of paper in the HP All-in-One. Review the following

recommendations to get the best printing and copying quality. Whenever you change

Load originals and load paper 21
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Chapter 6

paper types, remember to change the paper type settings. For more information, see Set
the paper type for printing.

This section contains the following topics:
 Recommended papers for printing and copying
¢« Recommended papers for printing only

e Papers to avoid

Recommended papers for printing and copying

If you want the best print quality, HP recommends using HP papers that are specifically
designed for the type of project you are printing. If you are printing photos, for example,
load HP Premium or HP Premium Plus photo paper in the input tray.

The following is a list of HP papers you can use for copying and printing. Depending on
your country/region, some of these papers might not be available.

HP Advanced Photo Paper or HP Photo Paper

HP Advanced Photo Paper or HP Photo Paper is a sturdy, glossy photo paper that
features an instant-dry finish for easy handling without smudging. It resists water, smears,
fingerprints, and humidity. Your prints have a look and feel comparable to a store-
processed photo. It is available in several sizes, including A4, 8.5 x 11 inch, and 10 x 15
cm (4 x 6 inch) (with or without tabs) for printing or copying photos from the product. HP
Advanced Photo Paper is marked on the nonprinting corners with the following symbol.

Il 2

HP Premium Inkjet Transparency Film

HP Premium Inkjet Transparency Film make your color presentations vivid and even more
impressive. This film is easy to use and handle and dries quickly without smudging.

HP Premium Inkjet Paper

HP Premium Inkjet Paper is the ultimate coated paper for high-resolution usage. A
smooth, matte finish makes it ideal for your highest-quality documents.

HP Bright White Inkjet Paper

HP Bright White Inkjet Paper delivers high-contrast colors and sharp text. It is opaque
enough for two-sided color usage with no show-through, which makes it ideal for
newsletters, reports, and flyers.
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HP All-in-One Paper or HP Printing Paper

* HP All-in-One Paper is specifically designed for HP All-in-One products. It has an
extra bright blue-white shade that produces sharper text and richer colors than
ordinary multifunction papers.

« HP Printing Paper is a high-quality multifunction paper. It produces documents that
look and feel more substantial than documents printed on standard multipurpose or

copy paper.
To order HP papers and other supplies, go to www.hp.com/buy/supplies. If prompted,

choose your country/region, follow the prompts to select your product, and then click one
of the shopping links on the page.

BY NOTE: Atthis time, some portions of the HP Web site are available in English only.

Recommended papers for printing only

Certain papers are supported only when you start the print job from your computer. The
following list provides information about these papers.

If you want the best print quality, HP recommends using HP papers. Using paper that is
too thin or too thick, paper that has a slick texture, or paper that stretches easily can cause
paper jams. Using paper that has a heavy texture or does not accept ink can cause printed
images to smear, bleed, or not fill in completely.

Depending on your country/region, some of these papers might not be available.

HP Iron-On Transfers

HP Iron-On Transfers (for color fabrics or for light or white fabrics) are the ideal solution
for creating custom T-shirts from your digital photos.

HP Brochure & Flyer Paper

HP Brochure & Flyer Paper (Gloss or Matte) is glossy-coated or matte-coated on both
sides for two-sided use. They are the perfect choice for near-photographic reproductions
and business graphics for report covers, special presentations, brochures, mailers, and
calendars.

HP Premium Presentation Paper
HP Premium Presentation Paper gives your presentation a quality look and feel.
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To order HP papers and other supplies, go to www.hp.com/buy/supplies. If prompted,
choose your country/region, follow the prompts to select your product, and then click one
of the shopping links on the page.

Bf NOTE: Atthis time, some portions of the HP Web site are available in English only.

Papers to avoid

Using paper that is too thin or too thick, paper that has a slick texture, or paper that
stretches easily can cause paper jams. Using paper that has a heavy texture or does not
accept ink can cause printed images to smeatr, bleed, or not fill in completely.
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Bf NOTE: For a complete list of supported media sizes, see the printer software.

Papers to avoid for all print and copy jobs
* Any size paper other than those listed in the printer software.

«  Paper with cutouts or perforations (unless specifically designed for use with HP inkjet
devices).

« Highly textured stock, such as linen. It might not print evenly, and the ink can bleed
into these papers.

- Extremely smooth, shiny, or coated papers not specifically designed for the HP All-
in-One. They can jam the HP All-in-One or repel the ink.

«  Multi-part forms, such as duplicate and triplicate forms. They can wrinkle or get stuck,
and the ink is more likely to smear.

« Envelopes with clasps or windows. They can get stuck in the rollers and cause paper
jams.

* Banner paper.

Additional papers to avoid when copying
«  Envelopes.

* Transparency film other than HP Premium Inkjet Transparency Film or HP Premium
Plus Inkjet Transparency Film.

e Iron-On Transfers.
« Greeting card paper.

Load paper

This section describes the procedure for loading different types and sizes of paper into
the HP All-in-One for your copies or printouts.

{} TIP: To help prevent rips, wrinkles, and curled or bent edges, store all paper flat in
aresealable bag. If the paper is not stored properly, extreme changes in temperature
and humidity might result in curled paper that does not work well in the HP All-in-One.

This section contains the following topics:
e Load full-size paper

e Load photo paper
* Load index cards

e Load envelopes
¢ Load other types of paper
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Load full-size paper
You can load many types of letter or A4 paper into the input tray of the HP All-in-One.
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To load full-size paper
1. Pull out the tray extension.

B NOTE: When you use legal-size paper, leave the tray extender closed.

2. Slide the paper-width guide to its outermost position.

3. Tap a stack of paper on a flat surface to align the edges, and then check the paper
for the following:

* Make sure it is free of rips, dust, wrinkles, and curled or bent edges.
e Make sure all the paper in the stack are the same size and type.
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4. Insert the stack of paper into the input tray with the short edge forward. Ensure that
the side you want to print on faces down. Slide the stack of paper toward the product
until it stops.

/\ CAUTION: Make sure that the product is idle and silent when you load paper
into the input tray. If the product is servicing the print cartridges or otherwise
engaged in a task, you could push the paper too far forward, causing the product
to eject blank pages.

{} TIP: If you are using letterhead, insert the top of the page first with the side you
want to print on facing down. For more help on loading full-size paper and
letterhead, refer to the diagram engraved in the base of the input tray.

5. Slide the paper-width guide inward until it stops at the edge of the paper.
Do not overload the input tray; make sure the stack of paper fits within the input tray
and is no higher than the top of the paper-width guide.

Load photo paper

You can load up to 216 x 279 mm (8.5 x 11 inch) photo paper into the input tray of the
product. For best results, use HP Advanced Photo Paper.
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ﬁ} TIP: To help prevent rips, wrinkles, and curled or bent edges, store all paper flat in
aresealable bag. If the paper is not stored properly, extreme changes in temperature
and humidity might result in curled paper that does not work well in the HP All-in-One.
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To load photo paper in the input tray
1. Remove all paper from the input tray.

2. Insert the stack of photo paper into the far-right side of the input tray with the print
side or glossy side down and short edge forward. Slide the stack of photo paper
toward the product until it stops.

{} TIP: For more help on loading small-size photo paper, refer to the guides
engraved in the base of the input tray for loading photo paper.

3. Slide the paper-width guide inward until it stops at the edge of the paper.
Do not overload the input tray; make sure the stack of paper fits within the input tray
and is no higher than the top of the paper-width guide.

For best results, set the paper type before copying or printing.

Related topics

¢ Recommended papers for printing and copying
* View the print resolution

» Set the copy paper type

Load index cards

You can load index cards into the input tray of the HP All-in-One to print notes, recipes,
and other text.

For best results, set the paper type before copying or printing.

Bf NOTE: The HP All-in-One leaves a 1.2 cm (0.5 inch) border on one short edge.
Before printing many cards, print one test card to make sure that the border does not
crop your text.
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To load index cards in the input tray

1. Remove all paper from the input tray.

2. Insert the stack of cards vertically (short edge facing outwards), with the side you
want to print on facing down, into the far-right side of the input tray. Slide the stack of
cards forward until it stops.

3. Slide the paper-width guide inward against the stack of cards until it stops.

Do not overload the input tray; make sure the stack of cards fits within the input tray
and is no higher than the top of the paper-width guide.

For best results, set the paper type before copying or printing.

Related topics

e Load photo paper

e View the print resolution
» Set the copy paper type

Load envelopes

You can load one or more envelopes into the input tray of the HP All-in-One. Do not use
shiny or embossed envelopes or envelopes that have clasps or windows.

B NOTE: For specific details on how to format text for printing on envelopes, consult
the help files in your word processing software. For best results, consider using a label
for the return address on envelopes.
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To load envelopes
1. Remove all paper from the input tray.

2. Insert one or more envelopes into the far-right side of the input tray, with the envelope
flaps on the left and facing up. Slide the stack of envelopes forward until it stops.

{} TIP: To avoid paper jams, tuck the flap inside each envelope.

TIP: For more help on loading envelopes, refer to the diagram engraved in the
base of the input tray.

3. Slide the paper-width guide inward against the stack of envelopes until it stops.
Do not overload the input tray; make sure the stack of envelopes fits within the input
tray and is not higher than the top of the paper-width guide.

Load other types of paper
The following papers require extra attention to load them properly.

BY NOTE: Not all paper sizes and paper types are available with all the functions on
the HP All-in-One. Some paper sizes and paper types can only be used if you are
starting a print job from the Print dialog box in a software application. They are not
available for copying. Papers that are only available for printing from a software
application are indicated as such.

HP Premium Inkjet Transparency Film

A Insert the film so that the white transparency strip (with arrows and the HP logo) is on
top and is going into the input tray first.

Bf NOTE: The HP All-in-One cannot automatically detect the paper type. For best
results, set the paper type to transparency film in the software before printing onto
transparency film.
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HP Iron-On Transfers (for printing only)
1. Flatten the transfer sheet completely before using it; do not load curled sheets.

{} TIP: To prevent curling, keep transfer sheets sealed in the original package until
you are ready to use them.

2. Locate the blue stripe on the nonprinting side of the transfer paper and then manually
feed one sheet at a time into the input tray with the blue stripe facing up.

Load paper 29



Chapter 6

For best results, set the paper type before copying or printing.

Related topics

e Load photo paper

e Set the paper type for printing
» Set the copy paper type
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7  Print from your computer

The HP All-in-One can be used with any software application that allows printing. You
can print a range of projects, such as borderless images, newsletters, greeting cards,
iron-on transfers, and posters.

This section contains the following topics:

e Print from a software application

e Make the HP All-in-One the default printer
* Change the print settings for the current job
» Change the default print settings

»  Printing shortcuts
» Perform special print jobs

e Stop a print job
¢ Resume a print job

Print from a software application

Most print settings are automatically handled by the software application. You need to
change the settings manually only when you change print quality, print on specific types
of paper or transparency film, or use special features.

To print from a software application

1. Make sure you have paper loaded in the input tray.

2. On the File menu in your software application, click Print.

3. Make sure the product is the selected printer.

4. If you need to change settings, click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

B NOTE: When printing a photo, you must select options for the specific photo
paper and photo enhancement.

5. Select the appropriate options for your print job by using the features available in the
Advanced, Printing Shortcuts, Features, and Color tabs.

{} TIP: You can easily select the appropriate options for your print job by choosing
one of the predefined print tasks on the Printing Shortcuts tab. Click a type of
print task in the Printing Shortcuts list. The default settings for that type of print
task are set and summarized on the Printing Shortcuts tab. If necessary, you
can adjust the settings here and save your custom settings as a new printing
shortcut. To save a custom printing shortcut, select the shortcut and click Save
As. To delete a shortcut, select the shortcut and click Delete.

6. Click OK to close the Properties dialog box.
7. Click Print or OK to begin printing.
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Make the HP All-in-One the default printer

You can set the HP All-in-One as the default printer to use from all software applications.
This means that the HP All-in-One is automatically selected in the printer list when you
select Print from the File menu in a software application. The default printer is
automatically selected when you click the Print button in the toolbar of most software
applications. For more information, see the Windows Help.

Change the print settings for the current job

You can customize the print settings of the HP All-in-One to handle nearly any print task.
This section contains the following topics:

e Set the paper size

¢ Set the paper type for printing

e View the print resolution

e Change the print speed or quality

e Change the page orientation

e Scale the document size

* Change the saturation, brightness, or color tone
e Preview your print job

Set the paper size
The paper size setting helps the HP All-in-One determine the printable area on the page.
Some of the paper size choices have a borderless equivalent, which allows you to print
to the top, bottom, and side edges of the paper.
Usually, you set the paper size in the software application you used to create your
document or project. However, if you are using custom-size paper, or if you cannot set

the paper size from your software application, you can change the paper size in the
Properties dialog box before printing.

To set the paper size

1. Make sure you have paper loaded in the input tray.

2. On the File menu in your software application, click Print.
3. Make sure the product is the selected printer.

4. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

Click the Features tab.
6. Inthe Resizing Options area, click the appropriate paper size from the Size list.

The following table lists the suggested paper size settings for the different types of
paper you can load in the input tray. Make sure to look at the long list of choices in

o
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the Size list to see if a defined paper size already exists for the type of paper you are
using.

Paper type Suggested paper size settings

Copier, multi-purpose, or Letter or A4

plain papers

Envelopes Appropriate listed envelope size

Greeting-card papers Letter or A4

Index cards Appropriate listed card size (if listed sizes are not appropriate,
you can specify a custom paper size)

Inkjet papers Letter or A4

Iron-on T-shirt transfers Letter or A4

Labels Letter or A4

Legal Legal

Letterhead Letter or A4

Panorama photo paper Appropriate listed panorama size (if listed sizes are not
appropriate, you can specify a custom paper size)

Photo papers 10x 15 cm (4 x 6 inch), L, 216 x 279 mm (8.5 x 11 inch), letter,
A4, or an appropriate listed size

Transparency films Letter or A4

Custom-size papers Custom paper size

Set the paper type for printing

If you print on special papers, such as photo paper, transparency film, envelopes, or
labels, or if you experience poor print quality, you can set the paper type manually.

To set the paper type for printing

1.

2.
3.
4

o

View the print resolution

The printer software displays the print resolution in dots per inch (dpi). The dpi varies
according to the paper type and print quality that you select in the printer software.

Make sure you have paper loaded in the input tray.

On the File menu in your software application, click Print.
Make sure the product is the selected printer.

Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

Click the Features tab.
In the Basic Options area, from the Paper Type drop-down list, select More.
Select the type of paper that you have loaded, and then click OK.
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To view the print resolution

1. Make sure you have paper loaded in the input tray.

2. On the File menu in your software application, click Print.
3. Make sure the product is the selected printer.

4. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

Click the Features tab.

6. Inthe Print Quality drop-down list, select the appropriate print quality setting for your
project.

7. Inthe Paper Type drop-down list, select the type of paper that you have loaded.

8. Click the Resolution button to view the print resolution dpi.

o

Change the print speed or quality

The HP All-in-One automatically chooses a print quality and speed setting depending on
the paper type setting you select. You can also change the print quality setting to
customize the speed and quality of the print process.

To select a print speed or quality

1. Make sure you have paper loaded in the input tray.

2. On the File menu in your software application, click Print.
3. Make sure the product is the selected printer.

4. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

Click the Features tab.

6. Inthe Print Quality drop-down list, select the appropriate quality setting for your
project.

o

Bf NOTE: To view the maximum dpi that the product will print, click Resolution.

7. Inthe Paper Type drop-down list, select the type of paper that you have loaded.

Change the page orientation

The page orientation setting allows you to print your document vertically or horizontally
on the page.

Usually, you set the page orientation in the software application you used to create your
document or project. However, if you are using custom-size or special HP paper, or if you
cannot set the page orientation from your software application, you can change the page
orientation in the Properties dialog box before printing.

To change the page orientation

1. Make sure you have paper loaded in the input tray.

2. On the File menu in your software application, click Print.
3. Make sure the product is the selected printer.
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Click the button that opens the Properties dialog box.
Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

Click the Features tab.

In the Basic Options area, do one of the following:

« Click Portrait to print the document vertically on the page.

« Click Landscape to print the document horizontally on the page.

Scale the document size

The HP All-in-One allows you to print the document at a different size than the original.

To scale the document size

1.

2.
3.
4

o

Make sure you have paper loaded in the input tray.

On the File menu in your software application, click Print.
Make sure the product is the selected printer.

Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

Click the Features tab.

In the Resizing options area, click Scale to paper size, and then click the
appropriate paper size from the drop-down list.

Change the saturation, brightness, or color tone

You can change the intensity of colors and the level of darkness in your printout by
adjusting the Saturation, Brightness, and Color Tone options.

To change the saturation, brightness, or color tone

1.

2.
3.
4

o

Preview your print job

You can preview your printjob before sending it to the HP All-in-One. This helps to prevent
wasting paper and ink on projects that do not print as expected.

Make sure you have paper loaded in the input tray.

On the File menu in your software application, click Print.
Make sure the product is the selected printer.

Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

Click the Color tab.

Click the More Color Options button.

Move the sliders to adjust the Saturation, Brightness, or Color Tone.

* Brightness indicates the lightness or darkness of the printed document.
e Saturation is the relative purity of printed colors.

« Color Tone affects the perceived warmth or coolness of printed colors, by adding
more orange or blue tones, respectively, to your image.

Change the print settings for the current job 35



Chapter 7

To preview your print job

1. Make sure you have paper loaded in the input tray.

2. On the File menu in your software application, click Print.
3. Make sure the product is the selected printer.

4. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

5. Select the print settings appropriate for your project on each of the tabs in the dialog
box.

6. Click the Features tab.

7. Select the Show Preview Before Printing check box.

8. Click OK, and then click Print or OK in the Print dialog box.
Your print job displays in the preview window.

9. Inthe HP preview window, do one of the following:
e To print, click Start Printing.
e To cancel, click Cancel Printing.

Change the default print settings

If there are settings that you frequently use for printing, you might want to make them the
default print settings so they are already set when you open the Print dialog box from
within your software application.

To change the default print settings

1. Inthe HP Solution Center, click Settings, point to Print Settings, and then click
Printer Settings.

2. Make changes to the print settings, and click OK.

Printing shortcuts

Use printing shortcuts to print with print settings that you use often. The printer software
has several specially designed printing shortcuts that are available in the Printing
Shortcuts list.

B NOTE: When you select a printing shortcut the appropriate printing options are
automatically displayed. You can leave them as is or change them. You can also
create a shortcut. For more information, see Create printing shortcuts.

Use the Printing Shortcuts tab for the following print tasks:

* General Everyday Printing: Print documents quickly.
* Photo Printing—Plain Paper: Print a photo on a plain paper.

« Photo Printing—Borderless: Print to the top, bottom, and side edges of 10 x 15 cm
(4 x 6 inch) and 216 x 279 mm (8.5 x 11 inch) HP Advanced Photo Papers.

* Photo Printing—With White Borders: Print a photo with a white border around the
edges.

* Fast/Economical printing: Produce draft-quality printouts quickly.
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Presentation printing: Print high-quality documents, including letters and
transparencies.

Two-sided (Duplex) Printing: Print two-sided pages with the HP All-in-One
manually.

This section contains the following topics:

Create printing shortcuts
Delete printing shortcuts

Related topics

Print a borderless image

Print a photo on plain paper
Print a photo on photo paper
Print on transparencies

Print on both sides of the page

Create printing shortcuts

In addition to the printing shortcuts that are available in the Printing Shortcuts list, you
can create your own printing shortcuts.

If you frequently print on transparency film, for example, you can create a printing shortcut
by selecting the Presentation Printing shortcut, changing the paper type to HP Premium
Inkjet Transparency Film, and then saving the modified shortcut under a new name; for
example, Transparency Presentations. After creating the printing shortcut, simply
select it when printing on transparency film rather than changing the print settings each
time.

To create a printing shortcut

1.
2.
3.

Delete printing shortcuts

You might want to delete printing shortcuts that you no longer use.

To delete a printing shortcut
1.
2.

On the File menu in your software application, click Print.
Make sure the product is the selected printer.
Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

Click the Printing Shortcuts tab.

In the Printing Shortcuts list, click a printing shortcut.

The print settings for the selected printing shortcut are displayed.

Change the print settings to those you want in the new printing shortcut.

Click Save as and type a name for the new printing shortcut, and then click Save.
The printing shortcut is added to the list.

On the File menu in your software application, click Print.
Make sure the product is the selected printer.
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3. Click the button that opens the Properties dialog box.
Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.
4. Click the Printing Shortcuts tab.
. Inthe Printing Shortcuts list, click the printing shortcut that you want to delete.
6. Click Delete.
The printing shortcut is removed from the list.

Bf NOTE: Only the shortcuts that you have created can be deleted. The original HP
shortcuts cannot be deleted.

Perform special print jobs

In addition to supporting standard print jobs, the HP All-in-One can perform special jobs
such as printing borderless images, iron-on transfers, and posters.

This section contains the following topics:

e Print a borderless image

e Print a photo on plain paper

e Print a photo on photo paper

e Print using Maximum dpi

e Print on both sides of the page

e Print a multiple-page document as a booklet

e Print multiple pages on a single sheet

e Print a multiple-page document in reverse order
¢ Reverse an image for iron-on transfers

e Print on transparencies

e Print a group of addresses on labels or envelopes
e Print a poster

e Print a Web page

Print a borderless image

Borderless printing lets you print to the top, bottom, and side edges of up to 216 x 279
mm (8.5 x 11 inch) photo paper.

ﬂ} TIP: For the best results, use HP Advanced Photo Papers to print your photos.

To print a borderless image
1. Remove all paper from the input tray.
2. Place the photo paper print side down on the right side of the input tray.
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3. On the File menu in your software application, click Print.
4. Make sure the product is the selected printer.
5. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

6. Click the Features tab.
7. Inthe Size list, click the size of photo paper loaded in the input tray.

If a borderless image can be printed on the specified size, the Borderless printing
check box is enabled.

8. Inthe Paper Type drop-down list, click More, and then select the appropriate paper
type.

Bf NOTE: You cannot print a borderless image if the paper type is set to Plain
paper or to a type of paper other than a photo paper.

9. Select the Borderless printing check box if it is not already checked.
If the borderless paper size and paper type are not compatible, the product software
displays an alert and allows you to select a different type or size.

10. Click OK, and then click Print or OK in the Print dialog box.

Bf NOTE: Do not leave unused photo paper in the input tray. The paper might start
to curl, which could reduce the quality of your printout. Photo paper should be flat
before printing.

Related topics
Load photo paper

Print a photo on plain paper

The HP All-in-One allows you to print photos on plain papers.

To print a photo on plain paper
1. Remove all paper from the input tray, and then load the plain paper print side down.

2. On the File menu in your software application, click Print.
3. Make sure the product is the selected printer.
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10.

11.

Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

Click the Features tab.

In the Basic Options area, select the appropriate plain paper type from the Paper
Type drop-down list.

In the Resizing Options area, click the appropriate paper size from the Size list.
If the paper size and paper type are not compatible, the product software displays an
alert and allows you to select a different type or size.

In the Basic Options area, select a print quality from the Print Quality drop-down
list. The default print quality is Normal.

Click OK to return to the Properties dialog box.

If you want to print the photo in black and white, click the Color tab and select the
Print in grayscale check box.

Click OK, and then click Print or OK in the Print dialog box.

NOTE: Do not leave unused plain paper in the input tray. The paper might start to
curl, which could reduce the quality of your printout. Plain paper should be flat before
printing.

Print a photo on photo paper

To achieve the best print quality, HP recommends using HP papers that are specifically
designed for the type of project you are printing along with genuine HP ink. HP papers
and HP ink are specifically designed to work well together to provide high-quality output.

For photo printing, HP recommends that you use HP Advanced Photo Papers with the
product.

To print a photo on photo paper

1.

Remove all paper from the input tray, and then load the photo paper print side down.

On the File menu in your software application, click Print.
Make sure the product is the selected printer.
Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

Click the Features tab.
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10.
11.

12.

In the Basic Options area, select the appropriate photo paper type from the Paper
Type drop-down list.

In the Resizing Options area, click the appropriate paper size from the Size list.

If the paper size and paper type are not compatible, the product software displays an
alert and allows you to select a different type or size.

In the Basic Options area, select a high print quality, such as Best, from the Print
Quality drop-down list.

Ifz? NOTE: For maximum dpi resolution, go to the Advanced tab, and then select
Enabled from the Maximum dpi drop-down list. For more information, see Print
using Maximum dpi.

In the HP Real Life Technologies area, click the Photo fix drop-down list and select
from the following options:

e Off: applies no HP Real Life Technologies to the image.
e Basic: enhances low-resolution images; moderately adjusts image sharpness.

* Full: automatically adjusts brightness, contrast, and sharpness; enhances low-
resolution images; automatically removes red-eye coloring in the photo.

{} TIP: You can remove red-eye coloring in the photo when using the Off or
Basic mode by selecting the Remove red eye check box.

Click OK to return to the Properties dialog box.

(Optional) If you want to print the photo in black and white, click the Color tab and

select the Print in grayscale check box. From the drop-down list, select one of the

following options:

« High Quality: uses all the available colors to print your photo in grayscale. This
creates smooth and natural shades of gray.

e Black Ink Only: uses black ink to print your photo in grayscale. The gray shading
is created by varying patterns of black dots, which might result in a grainy image.

Click OK, and then click Print or OK in the Print dialog box.

NOTE: Do not leave unused photo paper in the input tray. The paper might start to
curl, which could reduce the quality of your printout. Photo paper should be flat before
printing.

Print using Maximum dpi

Use maximum dpi mode to print high-quality, sharp images.

To get the most benefit from maximum dpi mode, use it to print high-quality images such
as digital photographs. When you select the maximum dpi setting, the printer software
displays the optimized dots per inch (dpi) that the HP All-in-One printer will print. Printing
in maximum dpi is supported on the following paper-types only:

HP Premium Plus Photo Paper
HP Premium Photo Paper

HP Advanced Photo Paper
Hagaki cards
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Printing in maximum dpi takes longer than printing with other settings and requires a large
amount of disk space.

To print in Maximum dpi mode

1. Make sure you have paper loaded in the input tray.

2. On the File menu in your software application, click Print.
3. Make sure the product is the selected printer.

4. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

Click the Advanced tab.

In the Printer Features area, select Enabled from the Maximum dpi drop-down list.
Click the Features tab.

In the Paper Type drop-down list, click More, and then select the appropriate paper
type.

9. Inthe Print Quality drop-down list, click Maximum dpi.

© N o g

Br NOTE: To view the maximum dpi that the product will print, click Resolution.

10. Select any other print settings that you want, and then click OK.

Related topics
Work with print cartridges

Print on both sides of the page

You can print two-sided pages with the HP All-in-One manually. When printing two-sided
pages, make sure to use paper that is thick enough so that images do not show through
to the other side.

To print on both sides of the page

1. Load paper into the input tray.

2. On the File menu in your software application, click Print.
3. Make sure the product is the selected printer.

4. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

Click the Features tab.

6. Inthe Paper saving options area, select Manual from the Two-sided printing drop-
down list.

o
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7. For binding, do one of the following:
« Forbinding on the top like a notebook or calendar, select the Flip Pages Up check
box.
This causes the odd and even pages of your document to print opposite of each
other top-to-bottom. This ensures that the top of the page is always at the top of
the sheet when you flip the pages up in your bound document.

» For binding on the side like a book or magazine, click to clear the Flip Pages
Up check box.
This causes the odd and even pages of your document to print opposite of each
other left-to-right. This ensures that the top of the page is always at the top of the
sheet when you turn the pages in your bound document.

B
B
A

8. Click OK, and then click Print or OK in the Print dialog box.
The product begins printing. Wait until all the odd-numbered pages are printed before
removing any of the printed pages from the output tray.
A dialog box displays instructions on the screen when it is time to process the second
side of your job.

9. Click Continue when done.

Print a multiple-page document as a booklet

The HP All-in-One allows you to print your document as a small booklet, which you can
fold and then staple together.

For best results, design your document to fit on a multiple of four pages, such as an 8,
12, or 16-page program for a child's school play or for a wedding.

1.9 47
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To print a multiple-page document as a booklet

1.

10.

11.

Load paper into the input tray.

The paper should be thick enough so that the images do not show through to the
other side.

On the File menu in your software application, click Print.

Make sure the product is the selected printer.

Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

Click the Features tab.

Inthe Paper saving options area, select Manual from the Two-sided printing drop-
down list.

Select the binding edge from the Booklet layout is list, as appropriate for your
language.

e If your language reads left-to-right, click Left edge binding.

« If your language reads right-to-left, click Right edge binding.

The Pages per sheet box is automatically set to two pages per sheet.

Click OK, and then click Print or OK in the Print dialog box.

The product begins printing.

A dialog box displays instructions on the screen when it is time to process the second
side of your job. Do not click Continue in the dialog box until you have reloaded the
paper as instructed in the following steps.

Wait until the product has stopped printing for several seconds before removing any
of the printed pages from the output tray.

If you remove the pages while the document is still printing, the pages might get out
of order.

Follow the instructions that appear on your screen for reloading the paper to print on
the second side, and then click Continue.

When the entire document has finished printing, fold the stack of paper in half, so that
the first page is on top, then staple the document along the crease.

{r TIP: For best results, use a saddle stapler, or a heavy-duty stapler with a long
reach to staple the booklet.
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Figure 7-1 Left-edge binding for left-to-right languages

513

Figure 7-2 Right-edge binding for right-to-left languages
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Print multiple pages on a single sheet

46

You can print up to 16 pages on a single sheet of paper.
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i
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To print multiple pages on a single sheet

1.

2.
3.
4

o

Make sure you have paper loaded in the input tray.

On the File menu in your software application, click Print.
Make sure the product is the selected printer.

Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

Click the Features tab.

In the Pages per sheet list, click 2, 4, 6, 9, or 16.

If you want a border to appear around each page image printed on the sheet of paper,
select the Print page borders check box.

In the Page order list, click an appropriate page order option.

The sample output graphic is numbered to show how the pages will be ordered if you
select each option.

Click OK, and then click Print or OK in the Print dialog box.
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Print a multiple-page document in reverse order

Because of the way the paper feeds through the HP All-in-One, the first page that prints
is print side up at the bottom of the stack. Usually this means you need to put the printed
pages in the correct order.

PNWhAO

N\W\

=

A better way is to print the document in reverse order so that the pages are stacked
correctly.

ORhWNE

WW\

=

s

PowbdrE

o o

- TIP: Set this option as a default setting so you do not have to remember to set it

every time you print a multiple-page document.

o print a multiple-page document in reverse order

Make sure you have paper loaded in the input tray.

On the File menu in your software application, click Print.
Make sure the product is the selected printer.

Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

Click the Advanced tab.
In the Layout Options area, select Front to Back in the Page Order option.

E¥ NOTE: If you set your document to print on both sides of the page, the Front to
Back option is not available. Your document will automatically print in the correct
order.

Click OK, and then click Print or OK in the Print dialog box.

Bf NOTE: When you are printing multiple copies, each set is printed completely
before the next set is printed.
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Reverse an image for iron-on transfers

This feature reverses an image so you can use it for iron-on transfers. This feature is also
useful for transparencies when you want to make notations on the back of the
transparency without scratching the original.

-

To reverse an image for iron-on transfers

1. On the File menu in your software application, click Print.
2. Make sure the product is the selected printer.

3. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

4. Click the Features tab.

In the Paper Type drop-down list, click More, and then select HP Iron-on Transfer
from the list.

If the selected size is not what you want, click an appropriate size in the Size list.
Click the Advanced tab.

In the Printer Features area, select On from the Mirror Image drop-down list.
Click OK, and then click Print or OK in the Print dialog box.

© 0 N o

Bf NOTE: To preventjams, manually feed the iron-on transfer sheets into the input
tray one sheet at a time.

Print on transparencies

For the best results, HP recommends you use HP transparency products with the HP All-
in-One.

To print on transparencies

1. Load the transparency into the input tray.

2. On the File menu in your software application, click Print.
3. Make sure the product is the selected printer.

4. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

5. Click the Features tab.
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6. Inthe Basic Options area, from the Paper Type drop-down list, select More. Then
select the appropriate paper type.

{} TIP: If you want to make notations on the back of the transparencies and erase
them later without scratching the original, click the Advanced tab, and select the
Mirror Image check box.

7. Inthe Resizing Options area, from the Size drop-down list, select More. Then, select
an appropriate size.

8. Click OK, and then click Print or OK in the Print dialog box.

BY NOTE: The product automatically waits for transparencies to dry before
releasing them. Ink dries slower on film than on plain paper. Make sure you allow
enough time for the ink to dry before handling the transparency.

Print a group of addresses on labels or envelopes

With the HP All-in-One, you can print on a single envelope, a group of envelopes, or label
sheets designed for inkjet printers.

To print a group of addresses on labels or envelopes
1. Print a test page on plain paper first.

2. Place the test page on top of the label sheet or envelope, and hold both up to the
light. Check the spacing for each block of text. Make adjustments as needed.

3. Load the labels or envelopes into the input tray.

/\ CAUTION: Do not use envelopes with clasps or windows. They can get stuck in
the rollers and cause paper jams.

4. If you are printing on envelopes, do the following:

a. Display the print settings, and click the Features tab.

b. Inthe Resizing Options area, click the appropriate envelope size in the Size list.
5. Click OK, and then click Print or OK in the Print dialog box.

Related topics
Load envelopes
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Print a poster

You can create a poster by printing a document on multiple pages. The HP All-in-One
prints dotted lines on some pages to indicate where to trim the pages before taping them
together.

-

To print a poster

1. Make sure you have paper loaded in the input tray.

2. On the File menu in your software application, click Print.

3. Make sure the product is the selected printer.

4. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,

Options, Printer Setup, Printer, or Preferences.

Click the Advanced tab.

Expand Document Options, and then expand Printer Features.

7. Inthe Poster Printing drop-down list, click either 2x2 (4 sheets), 3x3 (9 sheets),
4x4 (16 sheets), or 5x5 (25 sheets).
This selection tells the product to enlarge your document so that it fits on 4, 9, 16, or
25 pages.
If your originals are of multiple pages, each of those pages will be printed on 4, 9, 16,
or 25 pages. For example, if you have a one-page original and you select 3x3, you
will get 9 pages; if you select 3x3 for a two-page original, 18 pages will print.

8. Click OK, and then click Print or OK in the Print dialog box.

9. After the poster has printed, trim the edges of the sheets and tape the sheets together.

o a

Print a Web page
You can print a Web page from your Web browser on the HP All-in-One.

If you use Internet Explorer 6.0 or higher for Web browsing, you can use HP Smart Web
Printing to ensure simple, predictable web printing with control over what you want and
how you want it printed. You can access HP Smart Web Printing from the toolbar in
Internet Explorer. For more information about HP Smart Web Printing, see the help file
provided with it.
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To print a Web page
1. Make sure you have paper loaded in the input tray.
2. On the File menu in your Web browser, click Print.

X¥ TIP: For bestresults, select HP Smart Web Printing on the File menu. A check
mark appears when it is selected.

The Print dialog box appears.

3. Make sure the product is the selected printer.

4. If your Web browser supports it, select the items on the Web page that you want to
include in the printout.
For example, in Internet Explorer, click the Options tab to select options such as As
laid out on screen, Only the selected frame, and Print all linked documents.

5. Click Print or OK to print the Web page.

Q TIP: To print Web pages correctly, you might need to set your print orientation to
Landscape.

Stop a print job

Although you can stop a print job from either the HP All-in-One or the computer, HP
recommends you stop it from the HP All-in-One for best results.

To stop a print job from the HP All-in-One
A Press Cancel on the control panel. If the print job does not stop, press Cancel again.
It can take a few moments for printing to be cancelled.

To stop a print job from the computer (Windows Vista users)

1. On the Windows taskbar, click Start, and then click Control Panel.
2. Click Printers.

3. Double-click the product icon.

X¥ TIP: You can also double-click the printer icon in the Windows taskbar.

4. Select the print job you want to cancel.

5. On the Document menu, click Cancel Printing or Cancel, or press the Delete key
on your keyboard.

It can take a few moments for the print job to be cancelled.

To stop a print job from the computer (Windows XP users)

1. On the Windows taskbar, click Start, and then click Control Panel.
2. Open the Printers and Faxes control panel.

3. Double-click the product icon.

X¥ TIP: You can also double-click the printer icon in the Windows taskbar.
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4. Select the print job you want to cancel.

5. On the Document menu, click Cancel Printing or Cancel, or press the Delete key
on your keyboard.
It can take a few moments for the print job to be cancelled.

To stop a print job from the computer (Windows 2000 users)
1. On the Windows taskbar, click Start, point to Settings, and then click Printers.
2. Double-click the product icon.

X TIP: You can also double-click the printer icon in the Windows taskbar.

3. Select the print job you want to cancel.
4. On the Document menu, click Cancel or press the Delete key on your keyboard.
It can take a few moments for the print job to be cancelled.

Related topics
Control panel buttons

Resume a print job

If an error occurs while printing, you may need to resume the job from the HP All-in-One
or the computer after you address the error.

To resume a print job from the control panel
A On the control panel, press Resume.

To resume a print job from the computer (Windows Vista users)

1. On the Windows taskbar, click Start, and then click Control Panel.
2. Click Printers.

3. Double-click the product icon.

4} TIP: You can also double-click the printer icon in the Windows taskbar.

Select the print job you want to resume.
5. On the Document menu, click Resume Printing or Resume.
It can take a few moments to resume the print job.

To resume a print job from the computer (Windows XP users)

1. On the Windows taskbar, click Start, and then click Control Panel.
2. Open the Printers and Faxes control panel.

3. Double-click the product icon.

{'} TIP: You can also double-click the printer icon in the Windows taskbar.

Select the print job you want to resume.
5. On the Document menu, click Resume Printing or Resume.
It can take a few moments to resume the print job.
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To resume a print job from the computer (Windows 2000 users)
1. On the Windows taskbar, click Start, point to Settings, and then click Printers.
2. Double-click the product icon.

X¥ TIP: You can also double-click the printer icon in the Windows taskbar.

3. Select the print job you want to resume.
4. On the Document menu, click Resume.
It can take a few moments to resume the print job.

Related topics
Control panel buttons

Print
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8 Use the copy features

The HP All-in-One allows you to produce high-quality color and black-and-white copies
on a variety of paper types. You can enlarge or reduce the size of an original to fit a
specific paper size, adjust the copy quality, and make high-quality copies of photos,
including borderless copies.

This section contains the following topics:

» Make a copy

e Choose a layout

e Set the copy paper type

e Perform special copy jobs

e Stop copying
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Make a copy

You can make quality copies from the control panel.

O TIP: For quality copies, ensure that the scanner glass is clean and that there are no
foreign materials adhering to it. For more information, see Clean the glass.

To make a copy from the control panel
1. Make sure you have paper loaded in the input tray.
2. Load your original print side down on the right front corner of the glass.

{} TIP: You can make copies in different layouts by changing the orientation of the
original. For more information, see Choose a layout.

3. Press the Paper Selection button to set the paper type. For more information, see
Set the copy paper type.

4. Press Start Copy Black or Start Copy Color.

Related topics
Control panel buttons

Choose a layout

The layout of the copy depends on the orientation of the original loaded. You can also
make borderless copies by printing to the edges of the selected paper type by pressing
the Enlarge/Fit to Page button.

Refer to the table below for an indication of the layout of your copy.
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Layout of the copy

Orientation of

4x6 or L (Small Photo)

A or A4 (Plain or Photo)

original
Enlarge/Fit to Enlarge/Fit to Enlarge/Fit to Enlarge/Fit to
Page OFF Page ON Page OFF Page ON

=

H=|

0]

in l

-

Business Card
(Landscape)

Business Card
(Portrait)

[
=
=

4x6 Photo
(Landscape)

ol ]
il
=
=

4x6 Photo
(Portrait)

13

56 Use the copy features



(continued)

Layout of the copy

Two 4x6 Photos
(Portrait)

Orientation of 4x6 or L (Small Photo) A or A4 (Plain or Photo)
original
Enlarge/Fit to Enlarge/Fit to Enlarge/Fit to Enlarge/Fit to
Page OFF Page ON Page OFF Page ON

(%]
(0]
=

L &

O ()

ED >

o] oL

- 3
()
=
()
(2]
>

8.5x11 or A4
Document

Set the copy paper type

You can set the paper type for copying to Plain, Photo (Large), or Photo (Small).

Br NOTE: Copies made on plain paper are automatically made using Normal quality.
Copies made on photo paper are automatically made using Best quality.

Refer to the following table to determine which paper type setting to choose based on the
paper loaded in the input tray.

Paper type Control panel setting
Copier paper or letterhead Plain

HP Bright White Paper Plain

HP Advanced Photo Paper, Glossy Photo

HP Advanced Photo Paper, Matte Photo

HP Advanced 4 x 6 inch Photo Paper Photo (Small)

HP Photo Paper Photo

HP Everyday Photo Paper Photo

HP Everyday Photo Paper, Semi Gloss Photo

Other photo paper Photo

Set the copy paper type 57



C
(%]
o
-
=
)
o
o
°
<
=
@
2
=
S
@
(%2}

Chapter 8

(continued)

Paper type Control panel setting
HP Advanced Paper Plain
HP All-in-One Paper Plain
HP Printing Paper Plain
Other inkjet paper Plain
Legal Plain

Related topics
Control panel buttons

Perform special copy jobs

In addition to supporting standard copy jobs, the HP All-in-One can perform special jobs
such as making fast copies, making multiple copies, and copying borderless photos.

This section contains the following topics:
 Make a Fast copy

e Make multiple copies of the same original

e Make a borderless copy of a photo

e Copy a two-page black-and-white document

Make a Fast copy

58

A Fast copy prints faster with comparable quality text, but the graphics quality might be
lower. Fast copies use less ink and extend the life of your print cartridges. You can make
a Fast copy using the instructions below.

B NOTE: Copies made from the control panel on regular, plain paper automatically
use Normal quality.

To make a Fast copy
1. Make sure you have paper loaded in the input tray.
2. Load your original print side down on the right front corner of the glass.

{} TIP: For quality copies, ensure that the scanner glass is clean and that there are
no foreign materials adhering to it. For more information, see Clean the glass.

3. Press the Paper Selection button to set the paper type to Plain.

Bf NOTE: You cannot make a Fast copy if the paper type is set to Photo (Large)
or Photo (Small).

4. Press and hold down the Scan button, and then press either Start Copy Black or
Start Copy Color.
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Related topics
Control panel buttons
Set the copy paper type

Make multiple copies of the same original

You can set the number of copies from the control panel or from the software that you
installed with the HP All-in-One.

To make multiple copies of an original from the control panel
1. Make sure you have paper loaded in the input tray.
2. Load your original print side down on the right front corner of the glass.
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{r TIP: For quality copies, ensure that the scanner glass is clean and that there are
no foreigh materials adhering to it. For more information, see Clean the glass.

3. Press the Paper Selection button to set the paper type.
4. Press the Start Copy Black or Start Copy Color button to increase the number of

copies up to a maximum of 9 (varies by model). The product starts the copy job after
the last button press.

X TIP: Use the software that you installed with the product to set the number of
copies higher than 9.

In this example, the product makes six copies of the original 10 x 15 cm (4 x 6 inch)
photo.

Related topics
Control panel buttons

Make a borderless copy of a photo

To make a borderless copy of a photo, use the 10 x 15 cm (4 x 6 inch) or 216 x 280 mm
(8.5 x 11 inch) HP Advanced Photo Paper.

To make a borderless copy of a photo from the control panel

1. Load photo paper in the input tray. For more information on loading photo paper, see
Load photo paper.

2. Load your original print side down on the right front corner of the glass.

Bf NOTE: When loading a 10 x 15 cm (4 x 6 inch) original, ensure that the longer
side of the original is perfectly aligned with the front edge of the glass.
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Press the Paper Selection button to select either Photo (Large) or Photo (Small)
depending on the size of the paper loaded in the input tray.

BY NOTE: When copying a 10 x 15 c¢m (4 x 6 inch) original with 216 x 280 mm (8.5
x 11 inch) media loaded in the input tray, press Enlarge/Fit to Page to print a
borderless and enlarged copy of the original.

Press Start Copy Color.
The product makes a borderless copy of your original photo as shown below.

a4

Related topics
Control panel buttons

Copy a two-page black-and-white document

60

You can use the HP All-in-One to copy a single- or multiple-page document in color or
black and white. In this example, the HP All-in-One is used to copy a two-page black-
and-white original.

To copy atwo-page document from the control panel

1.
2.

Make sure you have paper loaded in the input tray.
Load your original print side down on the right front corner of the glass.

{} TIP: For quality copies, ensure that the scanner glass is clean and that there are
no foreign materials adhering to it. For more information, see Clean the glass.

Press the Paper Selection button to set the paper type.
Press Start Copy Black.

Wait until the product has finished printing the first page. Remove the first page from
the glass and load the second page.

Press Start Copy Black.
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Related topics
Control panel buttons

Stop copying

To stop copying
A Press Cancel on the control panel.

Related topics
Control panel buttons
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9 Usethe scan features

Scanning is the process of converting text and pictures into an electronic format for your
computer. You can scan almost anything (photos, magazine articles and text documents)
on the HP All-in-One.

BY NOTE: When scanning, the HP Photosmart Software enables you to save an image
in the following file formats: BMP, DCX, FPX, GIF, JPG, PCD, PCX, and TIF.

You can use the scanning features of the HP All-in-One to do the following:

* Scan text from an article into your word processor and quote it in a report.

« Printbusiness cards and brochures by scanning a logo and using it in your publishing
software.

» Send photos to friends and relatives by scanning your favorite prints and including
them in e-mail messages.

» Create a photographic inventory of your house or office.
* Archive treasured photos in an electronic scrapbook.

= NOTE: If you are using the product with a Windows 2000 computer, some features
may not be available. For more information, see Notice to Windows 2000 users.

NOTE: If you are using the HP Photosmart Software, the Optical Character
Recognition (OCR) software might not be installed on your computer. To install the
OCR software, you must re-insert the software disk and select OCR under the
Custom installation options.

Scan

This section contains the following topics:
e Scan an original

e Edit a scanned image

e Edit a scanned document

e Stop scanning

Scan an original

For original documents or images placed on the glass, you can start a scan from your
computer or from the HP All-in-One. This section explains the second option: how to scan
from the control panel of the HP All-in-One to a computer.

To use the scan features, the HP All-in-One and computer must be connected and turned
on. The HP Photosmart Software must also be installed and running on your computer
prior to scanning. To verify that the HP Photosmart Software is running on a Windows
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computer, look for the HP Digital Imaging Monitor icon in the system tray at the lower
right side of the screen, near the time.

Bf NOTE: Closing the HP Digital Imaging Monitor icon in the Windows system tray
can cause the HP All-in-One to lose some of its scan functionality. If this happens,
you can restore full functionality by restarting your computer or by starting the
HP Photosmart Software.

The HP Photosmart Software that you installed on your computer has many tools that
you can use to edit and print your scanned image. You can improve the overall image
quality by adjusting the brightness, sharpness, color tone, or saturation. You can also
crop, straighten, rotate, or resize the image. When the scanned image looks just the way
you want it, you can open it in another application, send it through e-mail, save it to a file,
or print it.

To scan to a computer

1. Load your original print side down on the right front corner of the glass.

2. Press Scan.
A preview image of the scan appears on your computer, where you can edit it. Any
edits that you make apply to the current scan session only.
The HP Photosmart Software has many tools that you can use to edit your scanned
image. You can improve the overall image quality by adjusting the brightness,
sharpness, color tone, or saturation. You can also crop, rotate, or resize the image.

3. Make any edits to the preview image, and then click Accept when you are finished.

Related topics
Control panel buttons
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Edit a scanned image

You can edit a scanned image, such as a photo or graphic, using the software you
installed with the HP All-in-One. Using this software, you can rotate or crop the image,
as well as adjust the brightness, contrast, and color saturation.

BY NOTE: If you are using the HP Photosmart Software, the Optical Character
Recognition (OCR) software might not be installed on your computer. To install the
OCR software, you must re-insert the software disk and select OCR under the
Custom installation options.

Related topics
Use the HP Photosmart software

Edit a scanned document

You can edit a scanned document using your Optical Character Recognition (OCR)
software. Scanning text using OCR software enables you to bring the content of magazine
articles, books, and other printed matter into your favorite word processor and many other
applications as editable text. Learning to use OCR software correctly is important if you
want to obtain the best results. Do not expect scanned text documents to be letter-perfect
the first time you use your OCR software. Using OCR software is an art that takes time
and practice to master.

Scan

BY NOTE: If you are using the HP Photosmart Software, the Optical Character
Recognition (OCR) software might not be installed on your computer. To install the
OCR software, you must re-insert the software disk and select OCR under the
Custom installation options.

Related topics
Use the HP Photosmart software

Stop scanning

To stop scanning
A Press Cancel on the control panel.

Related topics
Control panel buttons
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10 Maintain the HP All-in-One

The HP All-in-One requires little maintenance. Sometimes you might want to clean the
glass and lid backing to remove surface dust and ensure that your copies and scans
remain clear. You will also need to replace, align, or clean your print cartridges from time
to time. This section provides instructions for keeping the HP All-in-One in top working
condition. Perform these simple maintenance procedures as necessary.

This section contains the following topics:
e Clean the HP All-in-One

* Print a self-test report
*  Work with print cartridges

Clean the HP All-in-One
To ensure that your copies and scans remain clear, you might need to clean the glass
and lid backing. You might also want to dust the exterior of the HP All-in-One.
This section contains the following topics:
e Clean the exterior

e Clean the glass
» Clean the lid backing

Clean the exterior

Use a soft cloth or slightly moistened sponge to wipe dust, smudges, and stains off the
case. The interior of the HP All-in-One does not require cleaning. Keep fluids away from
the control panel and the interior of the HP All-in-One.

/\ CAUTION: To avoid damage to the exterior of the HP All-in-One, do not use alcohol
or alcohol-based cleaning products.

Clean the glass

Fingerprints, smudges, hair, and dust on the main glass surface slow down performance
and affect the accuracy of the copy and scan features.
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To clean the glass
1. Turn off the product, unplug the power cord, and raise the lid.

2. Clean the glass with a soft cloth or sponge slightly moistened with a nonabrasive
glass cleaner.

/\ CAUTION: Do not use abrasives, acetone, benzene, or carbon tetrachloride on
the glass, since they can damage it. Do not place or spray liquid directly on the
glass. The liquid might seep under the glass and damage the product.
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3. Dry the glass with a dry, soft, lint-free cloth to prevent spotting.
4. Plug in the power cord, and then turn on the product.

Clean the lid backing

Minor debris can accumulate on the white document backing located underneath the lid
of the HP All-in-One.

To clean the lid backing
1. Turn off the product, unplug the power cord, and raise the lid.

2. Clean the white document backing with a soft cloth or sponge slightly moistened with
a mild soap and warm water.
Wash the backing gently to loosen debris. Do not scrub the backing.
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3. Dry the backing with a dry, soft, lint-free cloth.

/\ CAUTION: Do not use paper-based wipes, as these might scratch the backing.
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4. If further cleaning is needed, repeat the previous steps using isopropyl (rubbing)
alcohol, and wipe the backing thoroughly with a damp cloth to remove any residual
alcohol.

/\ CAUTION: Be careful not to spill alcohol on the glass or exterior of the product,
as this might damage it.

5. Plug in the power cord, and then turn on the product.

Print a self-test report

If you are experiencing problems with printing, print a self-test report before you replace
the print cartridges. This report provides useful information on several aspects of your
product, including your print cartridges.

To print a self-test report
1. Load letter or A4 unused plain white paper into the input tray.
2. Press and hold the Cancel button and then press the Start Copy Color button.

The product prints a self-test report, which might indicate the source of the printing
problem. A sample of the ink test area of the report is shown below.

3. Make sure the test patterns show a complete grid and the thick color lines are
complete.

« If more than a few lines in a pattern are broken, this might indicate a problem with
the nozzles. You might need to clean the print cartridges.

» If the black line is missing, faded, streaked, or shows lines, this might indicate a
problem with the black print cartridge in the right slot.

« If any of the color lines are missing, faded, streaked, or show lines, this might
indicate a problem with the tri-color print cartridge in the left slot.

Related topics

e Clean the print cartridges

¢ Replace the print cartridges
» Control panel buttons
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Work with print cartridges

To ensure the best print quality from the product, you will need to perform some simple
maintenance procedures. This section provides guidelines for handling the print
cartridges and instructions for replacing, aligning, and cleaning the print cartridges.

You might also need to check your print cartridges if the Check Print Cartridge light is on.
This might mean that the print cartridges are not installed properly or are missing, the
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Chapter 10

plastic tape has not been removed from the print cartridges, the print cartridges are low
on ink, or the print carriage is blocked.

This section contains the following topics:
» Handle the print cartridges

e Check the estimated ink levels

e Choose the right print cartridges

e Replace the print cartridges

e Use ink-backup mode

e  Store the print cartridges

e Align the print cartridges

e Clean the print cartridges

e Clean the print cartridge contacts

e Clean the area around the ink nozzles
* Remove ink from your skin and clothing

Handle the print cartridges

70

Before you replace or clean a print cartridge, you should know the part names and how
to handle the print cartridges.

1 | Copper-colored contacts

2 | Plastic tape with pink pull tab (must be removed before installing)

Ink nozzles under tape

Hold the print cartridges by their black plastic sides, with the label on top. Do not touch
the copper-colored contacts or the ink nozzles.
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Br NOTE: Handle the print cartridges carefully. Dropping or jarring cartridges can cause
temporary printing problems, or even permanent damage.

Check the estimated ink levels

You can easily check the ink supply level to determine how soon you might need to
replace a print cartridge. The ink supply level shows an estimate of the amount of ink
remaining in the print cartridges. Actual ink levels may vary.

Q TIP: You can also print a self-test report to see if your print cartridges might need to
be replaced.

> NOTE: Ifthe print cartridges were used before being installed in the product, or have
been refilled, the estimated ink levels on the Estimated Ink levels tab may be
inaccurate or unavailable.

NOTE: Ink from the cartridges is used in the printing process in a number of different
ways, including in the initialization process, which prepares the product and cartridges
for printing, and in print head servicing, which keeps print nozzles clear and ink flowing
smoothly. In addition, some residual ink is left in the cartridge after it is used. For more
information, see www.hp.com/go/inkusage.

To check the ink levels from the HP Photosmart Software

1. Inthe HP Solution Center, click Settings, point to Print Settings, and then click
Printer Toolbox.

Bf NOTE: Youcan also open the Printer Toolbox from the Print Properties dialog
box. In the Print Properties dialog box, click the Features tab, and then click the
Printer Services button.

The Printer Toolbox appears.
2. Click the Estimated Ink Level tab.
The estimated ink levels for the print cartridges appear.

Related topics
Print a self-test report

Choose the right print cartridges
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HP recommends that you use original HP print cartridges. Original HP cartridges are
designed and tested with HP printers to help you easily produce great results, time after
time. Wherever you purchase printing supplies, check to see which of the following

Work with print cartridges 71


http://www.hp.com/go/inkusage

Chapter 10

options are available for your printer. Standard and value choices use the same cartridge
selection numbers.

Choose original HP cartridges for how you print

« Standard for everyday printing: You occasionally print directions, documents, and
even a photo now and then, but you still expect high quality and reliable printing. Our
standard cartridges give you the right value at the right price for your everyday printing
needs. Look for the blue package.

« Value for frequent printing: You print a lot—from e-mails and school reports to
family photos and holiday greetings. Buy more, save more with HP's value offerings.
Look for the green package.

« Specialty for performance printing: Enhance your specialty communications with
metallic ink—accent text, graphics, cards, announcements, reports, and even photos
with a reflective finish. Make your projects truly shine, using metallic ink. Look for the
red package.

Choose the cartridge combination for best results
« Text, graphics, and color photos: Combine tri-color and black print cartridges.
» Metallic accents: Combine tri-color and metallic print cartridges.”

Replace the print cartridges

When the ink level for the print cartridge is low, a message appears on your computer
screen. You can also check the ink levels by using the software installed with the HP All-
in-One. Follow these instructions when the ink level is low.

Bf NOTE: Ink level warnings and indicators provide estimates for planning purposes
only. When you receive a low-ink warning message, consider having a replacement
cartridge available to avoid possible printing delays. You do not need to replace the
print cartridges until print quality becomes unacceptable.

To order print cartridges for the HP All-in-One, go to www.hp.com/buy/supplies. If
prompted, choose your country/region, follow the prompts to select your product, and
then click one of the shopping links on the page.
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*  Metallic print cartridges are available in select countries/regions.
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To replace the print cartridges

1.

2.

3.

4.
5.

Make sure the product is on and you have letter or A4 unused plain white paper loaded
in the input tray.

Open the print cartridge door.

The print carriage should move to the far right side of the product. If the print carriage
does not move to the right side, turn the product off, and then on.

Wait until the print carriage is idle and silent, and then lightly press down on a print
cartridge to release it.

If you are replacing the tri-color print cartridge, remove the print cartridge from the
slot on the left.

If you are replacing the black print cartridge, remove the print cartridge from the slot
on the right.

1 | Print cartridge slot for the tri-color print cartridge

2 | Print cartridge slot for the black print cartridge
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Pull the print cartridge towards you out of its slot.

If you are disposing of the print cartridge, recycle the print cartridge. The HP Inkjet
Supplies Recycling Program is available in many countries/regions, and lets you
recycle used print cartridges free of charge. For more information, go to the following
Web site:

www.hp.com/hpinfo/globalcitizenship/environment/recycle/inkjet.html
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6. Remove the new print cartridge from its packaging, being careful to touch only the
black plastic. Gently remove the plastic tape using the pink pull tab.

Copper-colored contacts

2 | Plastic tape with pink pull tab (must be removed before installing)

Ink nozzles under tape

/\ CAUTION: Do not touch the copper-colored contacts or ink nozzles. Touching
these parts can result in clogs, ink failure, and bad electrical connections.

® &

7. Slide the new print cartridge at a slight upward angle into the empty slot. Then gently
push on the upper part of the print cartridge forward until it snaps into place.
If you are installing the tri-color print cartridge, slide it into the left slot.
If you are installing the black print cartridge, slide it into the right slot.
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8. Close the print cartridge door.

9. After the print cartridge alignment sheet prints, load it on the right front corner of the
glass with the top of the page to the right.

10. Press the Scan button.
The product aligns the print cartridges. Recycle or discard the print cartridge
alignment sheet.

Related topics
» Check the estimated ink levels
e Control panel buttons
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Use ink-backup mode

Use the ink-backup mode to operate the HP All-in-One with only one print cartridge. The
ink-backup mode is initiated when a print cartridge is removed from the print cartridge
carriage. During ink-backup mode, the product can only print jobs from the computer.
You cannot initiate a print job from the control panel (such as copying or scanning an
original).

BY NOTE: When the HP All-in-One operates in ink-backup mode, a message is
displayed on screen. If the message is displayed and two print cartridges are installed
in the product, verify that the protective piece of plastic tape has been removed from
each print cartridge. When plastic tape covers the print cartridge contacts, the product
cannot detect that the print cartridge is installed.
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For more information about ink-backup mode, see the following topics:

¢ Ink-backup mode output
e Exit ink-backup mode

Ink-backup mode output
Printing in ink-backup mode slows the printer and affects the quality of printouts.

Installed print cartridge Result

Black print cartridge Colors print as grayscale.

Colors print but black is grayed and is not a true

Tri-color print cartridge black.

Exit ink-backup mode
Install two print cartridges in the HP All-in-One to exit ink-backup mode.
For information about installing a print cartridge, see Replace the print cartridges.

Store the print cartridges

Follow these guidelines to maintain and store HP print cartridges and to ensure consistent

print quality.

*  When you remove a print cartridge from the product, store it in an airtight plastic
container to prevent the ink from drying out.

* Keep all unused print cartridges in their original sealed packages until they are
needed. Store print cartridges at room temperature (15-35 degrees C or 59-95
degrees F).

« Do not remove the plastic tape covering the ink nozzles until you are ready to install
the print cartridge in the product. If the plastic tape has been removed from the print
cartridge, do not attempt to reattach it. Reattaching the tape damages the print
cartridge.

/\ CAUTION: Always turn the product off with the On button before you unplug the
power cord or turn off a power strip. This allows the product to store the print cartridges
properly. When you store the product, always leave the active print cartridges inside
the product.

Align the print cartridges

Aligning the print cartridges ensures high-quality output. The HP All-in-One prompts you
to align and calibrate the print cartridges every time you install a new print cartridge. Make
sure you align the print cartridges when prompted to ensure excellent print quality.

B NOTE: If you remove and reinstall the same print cartridge, the HP All-in-One will
not prompt you to align the print cartridges. The HP All-in-One remembers the
alignment values for that print cartridge, so you do not need to realign the print
cartridges.
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To align newly installed print cartridges

1.

Before installing the print cartridges, make sure you have letter or A4 unused plain
white paper loaded in the input tray.

Once you install the cartridges, the product prints a print cartridge alignment sheet.
Load the print cartridge alignment sheet print side down on the right front corner of
the glass with the top of the page to the right.

Press the Scan button.

The product aligns the print cartridges. Recycle or discard the print cartridge
alignment sheet.

To align the print cartridges from the HP Photosmart Software

1.

Related topics
Control panel buttons

Load letter or A4 unused plain white paper into the input tray.

In the HP Solution Center, click Settings, point to Print Settings, and then click
Printer Toolbox.

B NOTE: You can also open the Printer Toolbox from the Print Properties dialog
box. In the Print Properties dialog box, click the Features tab, and then click the
Printer Services button.

The Printer Toolbox appears.

Click the Device Services tab.

Click Align the Print Cartridges.

The product prints a print cartridge alignment sheet.

Load the print cartridge alignment sheet print side down on the right front corner of
the glass.

Press the Scan button.

The product aligns the print cartridges. Recycle or discard the print cartridge
alignment sheet.

Clean the print cartridges

Use this feature when the self-test report shows streaking, white lines through any of the
lines of color or when a color is muddy after installing a print cartridge for the first time.
Do not clean print cartridges unnecessarily, as this wastes ink and shortens the life of the
ink nozzles.
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To clean the print cartridges from the HP Photosmart Software

1.
2.

Load letter, A4, or legal unused plain white paper into the input tray.

In the HP Solution Center, click Settings, point to Print Settings, and then click
Printer Toolbox.

B NOTE: You canalso open the Printer Toolbox from the Print Properties dialog
box. In the Print Properties dialog box, click the Features tab, and then click the
Printer Services button.

The Printer Toolbox appears.

Work with print cartridges 77



<
Q.
S
=
o
S
=
>
®
ac
o
P
5
o
=1
©

Chapter 10

3. Click the Device Services tab.
Click Clean the Print Cartridges.

5. Follow the prompts until you are satisfied with the quality of the output, and then click
Done.

If print quality still seems poor after you clean the print cartridges, try cleaning the
print cartridge contacts before replacing the affected print cartridge.

Related topics
¢ Clean the print cartridge contacts
¢ Replace the print cartridges

Clean the print cartridge contacts

/\ CAUTION: Do notclean the print cartridge contacts unless you are having a problem
with print quality and other measures have not been successful. For more information,
see Print quality troubleshooting.

Clean the print cartridge contacts if you get repeated messages on your computer screen
prompting you to check a print cartridge after you already have cleaned or aligned the
print cartridges, or if the Check Print Cartridge light is blinking.

Before cleaning the print cartridge contacts, remove the print cartridge and verify that
nothing is covering the print cartridge contacts, then reinstall the print cartridge. If you
continue to get messages to check the print cartridges, clean the print cartridge contacts.

Make sure you have the following materials available:

< Dry foam rubber swabs, lint-free cloth, or any soft material that will not come apart or
leave fibers.

{r TIP: Coffee filters are lint-free and work well for cleaning print cartridges.

- Distilled, filtered, or bottled water (tap water might contain contaminants that can
damage the print cartridges).

/\ CAUTION: Do not use platen cleaners or alcohol to clean the print cartridge
contacts. These can damage the print cartridge or the product.

To clean the print cartridge contacts
1. Turn on the product and open the print cartridge door.
The print carriage moves to the far right side of the product.
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2. Wait until the print carriage is idle and silent, and then unplug the power cord from
the back of the product.

3. Lightly press down on the print cartridge to release it, and then pull it towards you out
of the slot.

B NOTE: Do notremove both print cartridges at the same time. Remove and clean
each print cartridge one at a time. Do not leave a print cartridge outside the HP All-
in-One for more than 30 minutes.

4. Inspect the print cartridge contacts for ink and debris buildup.

5. Dip a clean foam rubber swab or lint-free cloth into distilled water, and squeeze any
excess water from it.

6. Hold the print cartridge by its sides.

7. Clean only the copper-colored contacts. Allow the print cartridges to dry for
approximately ten minutes.

1  Copper-colored contacts

2 | Ink nozzles (do not clean)

8. Hold the print cartridge with the HP logo on top, and insert the print cartridge back
into the slot. Make sure you push the print cartridge in firmly until it snaps into place.
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9. Repeat if necessary for the other print cartridge.

10. Gently close the print cartridge door and plug the power cord into the back of the
product.

Related topics
¢ Clean the area around the ink nozzles
¢ Replace the print cartridges

Clean the area around the ink nozzles

If the HP All-in-One is used in a dusty environment, a small amount of debris might
accumulate inside the device. This debris can include dust, hair, carpet, or clothing fibers.
When debris gets on the print cartridges, it can cause ink streaks and smudges on printed
pages. Ink streaking can be corrected by cleaning around the ink nozzles as described
here.

B NOTE: Clean the area around the ink nozzles only if you continue to see streaks
and smudges on your printed pages after you have already cleaned the print
cartridges by using the software you installed with the HP All-in-One.

Make sure you have the following materials available:

*  Dry foam rubber swabs, lint-free cloth, or any soft material that will not come apart or
leave fibers.

{} TIP: Coffee filters are lint-free and work well for cleaning print cartridges.

- Distilled, filtered, or bottled water (tap water might contain contaminants that can
damage the print cartridges).

/\ CAUTION: Do not touch the copper-colored contacts or ink nozzles. Touching
these parts can result in clogs, ink failure, and bad electrical connections.
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To clean the area around the ink nozzles

1.

w

o o A

Turn on the product and open the print cartridge door.
The print carriage moves to the far right side of the product.

Wait until the print carriage is idle and silent, and then unplug the power cord from
the back of the product.

Lightly press down on the print cartridge to release it, and then pull it towards you out
of the slot.

B NOTE: Do notremove both print cartridges at the same time. Remove and clean
each print cartridge one atatime. Do not leave a print cartridge outside the product
for more than 30 minutes.

Place the print cartridge on a piece of paper with the ink nozzles facing up.
Lightly moisten a clean foam rubber swab with distilled water.
Clean the face and edges around the ink nozzle area with the swab, as shown below.

1  Nozzle plate (do not clean)
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2 | Face and edges around the ink nozzle area

/\ CAUTION: Do not clean the nozzle plate.
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7. Hold the print cartridge with the HP logo on top, and insert the print cartridge back
into the slot. Make sure you push the print cartridge in firmly until it snaps into place.

8. Repeat if necessary for the other print cartridge.

9. Gently close the print cartridge door and plug the power cord into the back of the
product.

Related topics
Clean the print cartridges

Remove ink from your skin and clothing

82

Follow these instructions to remove ink from your skin and clothing:

Surface Remedy

Skin Wash the area with an abrasive soap.

White fabric Wash the fabric in cold water and use chlorine bleach.
Color fabric Wash the fabric in cold water and use sudsy ammonia.

/\ CAUTION: Always use cold water to remove ink from fabric. Warm or hot water can
set the ink into the fabric.
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11 Shop for ink supplies

For a list of print cartridge numbers, see the printed documentation that came with the
HP All-in-One. You can also use the software that came with the HP All-in-One to find
out the reorder number for all the print cartridges. You can order print cartridges online
from the HP Web site. Additionally, you can contact a local HP reseller to find out the

correct print cartridge reorder numbers for your product and purchase print cartridges.

To order genuine HP supplies for the HP All-in-One, go to www.hp.com/buy/supplies. If
prompted, choose your country/region, follow the prompts to select your product, and
then click one of the shopping links on the page.

Br NOTE: Ordering print cartridges online is not supported in all countries/regions. If it
is not supported in your country/region, contact a local HP reseller for information
about purchasing print cartridges.

To order print cartridges from your desktop

A Click the Shop for HP Supplies icon on your desktop to connect to HP SureSupply.
You will see alist of original HP printing supplies that are compatible with your device,
as well as options to conveniently purchase the supplies you need (options vary by
country/region).
If you deleted this icon from your desktop, click the Start menu, point to the HP folder,
then click Shop for Supplies.

To order print cartridges through the HP Photosmart Software

1. Inthe HP Solution Center, click Settings, point to Print Settings, and then click
Printer Toolbox.

B NOTE: Youcan also open the Printer Toolbox from the Print Properties dialog
box. In the Print Properties dialog box, click the Features tab, and then click the
Printer Services button.

2. Click the Estimated Ink Levels tab.

3. Click Print Cartridge Ordering Information.
The print cartridge reorder numbers appear.

4. Click Order Online.
HP sends detailed printer information, including model number, serial number, and
ink supply levels, to an authorized online reseller. The supplies you need are
preselected; you can change quantities, add or remove items, and then check out.
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12 Troubleshooting

This section contains the following topics:

* View the Readme file

e Hardware setup troubleshooting

e Software installation troubleshooting
e Paper jams

e Print cartridge troubleshooting

e Print quality troubleshooting

e Print troubleshooting

» Copy troubleshooting

e Scan troubleshooting

e Ermors
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View the Readme file

You might want to refer to the Readme file for information on system requirements and
possible installation problems.

You can access the Readme file by clicking Start, pointing to Programs or All
Programs, pointing to HP, pointing to Deskjet F4200 All-In-One series, and then
clicking Readme.

You can access the Readme file by double-clicking the icon located in the top-level folder
of the HP All-in-One software CD-ROM.

Hardware setup troubleshooting

This section contains hardware troubleshooting information for the product.

Many issues are caused when the product is connected to the computer using a USB
cable before the HP Photosmart software is installed on the computer. If you connected
the product to your computer before the software installation screen prompts you to do
so0, you must follow these steps:

Troubleshooting common setup issues
1. Disconnect the USB cable from the computer.

2. Uninstall the software (if you have already installed it).
For more information, see Uninstall and reinstall the software.

Restart your computer.
Turn off the product, wait one minute, then restart it.
Reinstall the HP Photosmart software.

> o & w

CAUTION: Do not connect the USB cable to the computer until prompted by the
software installation screen.
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This section contains the following topics:

e The product will not turn on
* | connected the USB cable, but | am having problems using the HP All-in-One with

my computer
* After setting up the product, it does not print

The product will not turn on

Try the following solutions if there are no light indications, no noise, and no movement
from the printer when you turn on the product.

e Solution 1: Make sure you are using the power cord that came with the product

e Solution 2: Reset the product

e Solution 3: Press the On button more slowly

e Solution 4: Contact HP to replace the power supply

e Solution 5: Contact HP support for service
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Solution 1: Make sure you are using the power cord that came with the product

Solution:

» Make sure the power cord is firmly connected to both the product and the power
adapter. Plug the power cord into a power outlet, surge protector, or power strip.

Power connection

Power cord and adapter

3 | Power outlet

« If you are using a power strip, make sure the power strip is on. Or, try plugging
the product directly into a power outlet.
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« Test the power outlet to make sure it is working. Plug in an appliance that you
know works, and see if the appliance has power. If not, then there might be a
problem with the power outlet.

« Ifyou plugged the product into a switched outlet, make sure the outlet is switched
on. If it is switched to on but still does not work, then there might be a problem
with the power outlet.

Cause: The product was not being used with the power cord it was shipped with.
If this did not solve the issue, try the next solution.

Solution 2: Reset the product
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Solution: Turn off the product, and then unplug the power cord. Plug the power
cord back in, and then press the On button to turn on the product.

Cause: The product experienced an error.
If this did not solve the issue, try the next solution.

Solution 3: Press the On button more slowly

Solution: The product might not respond if you press the On button too quickly.
Press the On button once. It might take a few minutes for the product to turn on. If
you press the On button again during this time, you might turn the product off.

/\ CAUTION: Ifthe product still does not turn on, it might have a mechanical failure.
Unplug the product from the power outlet.

Contact HP support for service.

Go to: www.hp.com/support. If prompted, choose your country/region, and then
click Contact HP for information on calling for technical support.

If this did not solve the issue, try the next solution.
Cause: You pressed the On button too quickly.
If this did not solve the issue, try the next solution.

Solution 4: Contact HP to replace the power supply
Solution: Contact HP support for service.

Go to: www.hp.com/support.

If prompted, choose your country/region, and then click Contact HP for information
on calling for technical support.

Cause: The ink cartridge(s) were not intended for use in this product.
If this did not solve the issue, try the next solution.
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Solution 5: Contact HP support for service

Solution: If you have completed all of the steps provided in the previous solutions
and are still having a problem, contact HP support for service.

Go to: www.hp.com/support.

If prompted, choose your country/region, and then click Contact HP for technical
support.

Cause: You might need assistance to enable the product or software to function
properly.
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I connected the USB cable, but I am having problems using the HP All-in-One with
my computer

Solution: You must first install the software that came with the product before
connecting the USB cable. During installation, do not plug in the USB cable until
prompted by the onscreen instructions.

Once you have installed the software, connecting your computer to the product with
a USB cable is straightforward. Simply plug one end of the USB cable into the back
of your computer and the other into the back of the product. You can connect to any
USB port on the back of your computer.

If you installed the software, uninstall it and then reinstall it, connecting the USB cable
only when prompted.

For more information on installing the software and connecting the USB cable, see
the Setup Guide that came with the product.

Cause: The USB cable was connected before the software was installed.
Connecting the USB cable before prompted can cause errors.
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After setting up the product, it does not print

Solution:

Look at the On button located on the product. If it is not lit, the product is turned
off. Make sure the power cord is firmly connected to the product and plugged into
a power outlet. Press the On button to turn on the product.

Make sure the print cartridges are installed.

Make sure you have paper loaded in the input tray.

Make sure that the product does not have a paper jam.

Check that the print carriage is not jammed.

Open the front access door to access the print carriage area. Remove any objects
that are blocking the print carriage, including any packing materials. Turn the
product off and then turn it on again.

Print a test page to see if the product can print and is communicating with the
computer. For more information, see Print a self-test report.

Make sure that the print queue is not paused. If itis, choose the appropriate setting
to resume printing. For more information about accessing the print queue, see
the documentation that came with the operating system installed on your
computer.

Check the USB cable. If you are using an older cable, it might not be working
properly. Try connecting it to another product to see if the USB cable works. If
you experience problems, the USB cable might need to be replaced. Also verify
that the cable does not exceed 3 meters (9.8 feet) in length.

Make sure your computer is USB ready and that you are using a supported
operating system. For more information, see the Readme file.

Check the connection from the product to your computer. Verify that the USB
cable is securely plugged into the USB port on the back of the product. Make sure
the other end of the USB cable is plugged into a USB port on your computer. After
the cable is connected properly, turn the product off and then on again.
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If you are connecting the product through a USB hub, make sure the hub is turned
on. If the hub is on, try connecting directly to your computer.

Hardware setup troubleshooting 89



Chapter 12

«  Check other printers or scanners. You might need to disconnect older products
from your computer.

« Try connecting the USB cable to another USB port on your computer. After you
check the connections, try restarting your computer. Turn the product off and then
on again.

»  After you check the connections, try restarting your computer. Turn the product
off and then on again.

« If necessary, remove and then install the software you installed with the product
again. For more information, see Uninstall and reinstall the software.

For more information on setting up the product and connecting it to your computer,
see the Setup Guide that came with the product.
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Cause: The product and computer were not communicating with each other.

Software installation troubleshooting

Use this section to solve any problems you might encounter while setting up the
HP Photosmart software.

This section contains the following topics:

¢ When linsert the CD-ROM into my computer's CD-ROM drive, nothing happens
e The Minimum System Checks screen appears

e Ared X appears on the USB connect prompt

e | received a message that an Unknown Error has occurred

e Some of the buttons are missing in the HP Solution Center

e The registration screen does not appear

e The HP Digital Imaging Monitor does not appear in the system tray

e Uninstall and reinstall the software

When | insert the CD-ROM into my computer’s CD-ROM drive, nothing happens
Solution: If the installation does not run automatically, you can start it manually.

To start the installation from a Windows computer

1. From the Windows Start menu, click Run.

2. In the Run dialog box, enter d:\setup.exe, and then click OK.
If your CD-ROM drive is not assigned to drive letter D, enter the appropriate drive
letter.

Cause: The installation failed to run automatically.

The Minimum System Checks screen appears

Solution: Click Details to see what the specific problem is, and then correct the
problem before attempting to install the software.

Cause: Your system did not meet the minimum requirements to install the software.
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A red X ap

Solution: Verify that the product is set up properly, and then try to re-establish the
connection.

To retry the USB connection
1. Verify that the USB cable is set up properly as follows:

pears on the USB connect prompt

Unplug the USB cable and plug it in again or try plugging the USB cable into
a different USB port.

Do not attach the USB cable to a keyboard.
Verify that the USB cable is 3 meters (9.8 feet) or less in length.

If you have several USB devices attached to your computer, you might want
to unplug the other devices during the installation.
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2. Unplug the product power cord, and then plug it in again.
3. Verify that the USB cable and power cord are plugged in.

4. Click Retry to retry the connection.
5. Continue with the installation and restart the computer when prompted.

Cause:

Normally, a green check appears indicating that the plug and play was

successful. A red X indicates that the plug and play failed.

| received a message that an Unknown Error has occurred

Solution: Try to continue with the installation. If that does not work, stop and then
restart the installation, and follow the directions on the screen. If an error occurs, you
might need to uninstall and then reinstall the software. Do not simply delete the
product application files from your computer. Make sure to remove them properly
using the uninstall utility provided when you installed the software that came with the
product.

For more information, see:

Uninstall and reinstall the software

Cause:

The source of the error is unknown.

Software installation troubleshooting 91



—
=
o
=
=
@®
4]
>
o
o
=3
=
Q

Chapter 12

Some of the buttons are missing in the HP Solution Center

Solution: If the appropriate icons and buttons for your product do not appear in the
HP Solution Center, your installation might not be complete, and you might need to

uninstall and then reinstall the software. Do not simply delete the product application
files from your hard drive. Make sure to remove them properly using the uninstall utility
provided in the HP All-in-One program group.

For more information, see:

Uninstall and reinstall the software

Cause: The installation might not be complete.

The registration screen does not appear

Solution: You can access the registration (Sign up now) screen from the Windows
taskbar by clicking Start, pointing to Programs or All Programs, HP, Deskjet F4200
All-In-One series, and then clicking Product Registration.

Cause: The registration screen did not launch automatically.

The HP Digital Imaging Monitor does not appear in the system tray

Solution: If the HP Digital Imaging Monitor does not appear in the system tray
(normally located at the lower-right corner of the desktop), start the HP Solution
Center.

If the appropriate icons and buttons for your product do not appear in the HP Solution
Center, your installation might not be complete, and you might need to uninstall and
then reinstall the software. Do not simply delete the product application files from your
hard drive. Make sure to remove them properly using the uninstall utility provided in
the HP All-in-One program group.
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For more information, see:
Uninstall and reinstall the software

Cause: The installation might not be complete.

Uninstall and reinstall the software

If your installation is incomplete, or if you connected the USB cable to the computer before
prompted by the software installation screen, you might need to uninstall and then
reinstall the software. Do not simply delete the HP All-in-One application files from your
computer. Make sure to remove them properly using the uninstall utility provided when
you installed the software that came with the HP All-in-One.
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To uninstall from a Windows computer

Bf NOTE: Use this method if Uninstall is not available in the Windows Start menu (click
Programs or All Programs, HP, Deskjet F4200 All-In-One series, Uninstall).

1. Open the Windows control panel and double-click Add or Remove Programs.

B NOTE: The procedure to open the control panel varies by operating system. If
you are not sure how to do this, see the Windows Help.

2. Select HP Deskjet All-In-One Driver Software, and then click Change/Remove.
Follow the onscreen instructions.

3. Disconnect the product from your computer.

4. Restart your computer.

Bf NOTE: Itis important that you disconnect the product before restarting your
computer. Do not connect the product to your computer until after you have
reinstalled the software.

5. Insert the product CD-ROM into your computer’s CD-ROM drive and then start the
Setup program.

6. Follow the onscreen instructions and the instructions provided in the Setup Guide that
came with the product.
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When the software installation is complete, the HP Digital Imaging Monitor icon appears
in the Windows system tray.
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To verify that the software is properly installed, double-click the HP Solution Center icon
on the desktop. If the HP Solution Center shows the essential icons (Scan Picture and
Scan Document), the software has been properly installed.

Paper jams
To help avoid paper jams, follow these guidelines:

* Remove printed papers from the output tray frequently.
« Prevent curled or wrinkled paper by storing all unused paper flat in a resealable bag.
< Ensure that paper loaded in the input tray lays flat and the edges are not bent or torn.

- Do not combine different paper types and paper sizes in the input tray; the entire stack
of paper in the input tray must be the same size and type.

« Adjust the paper-width guide in the input tray to fit snugly against all paper. Make sure
the paper-width guide does not bend the paper in the input tray.

» Do not force paper too far forward in the input tray.
« Use paper types that are recommended for the product.
For more information, see the following topics:

e Clear paper jams
¢ |Information on paper

Clear paper jams
Solution: In case of a paper jam, first check the rear access door.
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If the jammed paper is notin the rear rollers, check the front access door. Occasionally
small media jams may not be reachable from the rear access door. Use the front
access door if unable to clear the jam from the rear access door.

To clear a paper jam from the rear access door

1. Press in the tab on the left side of the rear access door to release the door.
Remove the door by pulling it away from the product.
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2. Gently pull the paper out of the rollers.

/\ CAUTION: Ifthe paper tears when you are removing it from the rollers, check
the rollers and wheels for torn pieces of paper that might be remaining inside
the product. If you do not remove all the pieces of paper from the product,
more paper jams are likely to occur.

3. Replace the rear access door. Gently push the door forward until it snaps into
place.

4. Press Resume to continue the current job.

To clear a paper jam from the front access door
1. Pull the input tray down to open the front access door.
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2. Gently pull out any paper that might have jammed.

/\ CAUTION: Ifthe paper tears when you are removing it, check for torn pieces
of paper that might be remaining inside the product. If you do not remove all
the pieces of paper from the product, more paper jams are likely to occur.

3. Close the front access door.
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4. Press Resume to continue the current job.

Cause: Paper had jammed in the product.

Information on paper

The product is designed to work well with most paper types. Test a variety of paper types
before buying a large quantity. Find a paper type that works well and is easy to purchase.
HP Advanced papers are designed for the best quality results. In addition, follow these
tips:

- Do not use paper that is too thin, that has a slick texture, or that stretches easily. It
can feed incorrectly through the paper path, causing paper jams.

- Store photo media in its original packaging inside a resealable plastic bag on a flat
surface in a cool, dry place. When you are ready to print, remove only the paper you
plan to use immediately. When you have finished printing, return any unused photo
paper to the plastic bag.

- Do notleave unused photo paper in the input tray. The paper might start to curl, which
might reduce the quality of your printouts. Curled paper can also cause paper jams.

« Always hold photo paper by the edges. Fingerprints on photo paper can reduce print
quality.

- Do not use paper that is heavily textured. It can cause graphics or text to print
improperly.

< Do not combine different paper types and paper sizes in the input tray; the entire stack
of paper in the input tray must be the same size and type.

«  Store printed photos under glass or in a storage book to prevent bleeding over time
from high humidity. Use HP Advanced Photo Papers for maximum performance.

Print cartridge troubleshooting

If you are experiencing problems with printing, you might have a problem with one of the
print cartridges. If you receive an error message about the print cartridges, see Print
cartridge messages for more information.
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Try the following:

Information on print cartridges

For best results, use HP print cartridges. The following tips help maintain HP print
cartridges and ensure consistent print quality.

Information on print cartridges
Resolving print cartridge problems
Resolving print cartridge error messages

Keep all print cartridges in the original sealed packages until they are needed.
Store print cartridges at room temperature (15.6°-26.6° C or 60°-78° F).

Do not reattach the protective tape once it has been removed from the print cartridge.
Reattaching the plastic tape might damage the print cartridge. Place the print cartridge
in the product immediately after removing the plastic tape. If this is not possible, store
it in a print cartridge protector or airtight plastic container.

HP recommends that you do not remove the print cartridges from the product until
you have replacement print cartridges available to install.

Turn off the product from the control panel. Do not turn off the product by turning off
a power strip or unplugging the power cord from the product. If you improperly turn
off the product, the print carriage does not return to the correct position and the print
cartridges can dry out.

Do not open the print cartridge door unless necessary. This exposes the print
cartridges to air, which reduces the life of the print cartridges.
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Bf NOTE: If you leave the print cartridge door open for a long period of time, the
product will recap the print cartridges to protect them from exposure to air.

It might be necessary to clean the print cartridges when you notice a significant
decrease in print quality.

{r TIP: You might notice a decrease in print quality if the print cartridges have not
been used for a long time.

Do not clean the print cartridges unnecessarily. This wastes ink and shortens the life
of the cartridges.

Handle print cartridges carefully. Dropping, jarring, or rough handling during
installation can cause temporary printing problems. If print quality is poor right after
cartridge installation, allow half an hour for the print cartridge to recover.

For more information, see:

Print cartridge troubleshooting
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Resolving print cartridge problems

Many problems can be resolved with the following procedures. If you receive a specific
error message about the print cartridges, see Print cartridge messages for more
information.

To troubleshoot the print cartridges
1. Remove and reinstall the print cartridges.
For more information, see Replace the print cartridges.

BY NOTE: Make sure the plastic tape has been removed. If it is still covering the ink
nozzles, gently remove the plastic tape by using the pink pull tab.

2. If print quality is suffering, check the estimated ink levels.
For more information, see Check the estimated ink levels.
3. Print a self-test report and review the test patterns.
For more information, see Print a self-test report.
4. Clean the print cartridges:

* First, try cleaning the print cartridges from the HP Photosmart Software. For more
information, see Clean the print cartridges.

/\ CAUTION: Performing this procedure unnecessarily can waste ink and
shorten the life of the cartridges.

« If cleaning the print cartridges from the software did not help, you can try cleaning
the print cartridge contacts. For more information, see Clean the print cartridge
contacts.

5. If none of the previous procedures resolved the problem, replace the print cartridges.

For more information, see Replace the print cartridges.

Resolving print cartridge error messages

After you install a print cartridge, one or both of the print cartridge status lights begin to
blink. The printer will not print. One of the following messages may appear on your
computer screen:

Print Cartridge Problem
Incorrect Print Cartridge(s)
Incorrectly Installed Cartridge(s)
Print Cartridge(s) Missing

Work through the following sections in order. When the print cartridge light stops blinking,
you have solved the problem.
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Bf NOTE: In the procedures below, the problem cartridge is identified by the blinking
light. The light on the left blinks when the tri-color print cartridge (on the left) is the
problem, the light on the right blinks when the black cartridge (on the right) is the
problem, and both lights blink when both cartridges are the problem.

e Solution 1: Remove and reinstall the print cartridges
* Solution 2: Clean the print cartridge contacts
» Solution 3: Print in ink-backup mode

Solution 1: Remove and reinstall the print cartridges

Solution: The print cartridge may not have full electrical contact with the printer.
Removing and reinstalling the cartridge may help.
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B NOTE: HP cannotguarantee the quality of remanufactured or refilled cartridges.

To verify and install the correct print cartridges
1. Make sure the product is on. Press the On button if it is not lit.

2. Open the print cartridge door, and then wait until the print carriage is idle and
silent.

Press down lightly on the end of the problem cartridge to release it.
Slide the cartridge out and inspect it:

Hw

/\ CAUTION: Do not touch the copper electrical contacts or the ink nozzles.

e Check the electrical contacts for debris.
e Make sure all the clear nozzle protective tape has been removed.

/\ CAUTION: Do not attempt to remove the copper electrical strip!

5. Read the selection number on the print cartridge label and make sure it is
compatible with the product. Compatible print cartridges are listed in the printed
documentation that came with the product.

1 ‘ Selection number

6. If the print cartridge has the wrong selection number, install a new print cartridge.
For more information, see Replace the print cartridges.

7. Close the print cartridge door.
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If this did not solve the issue, try the next solution.

Solution 2: Clean the print cartridge contacts

Solution: If the print cartridge selection number is correct and the previous solution
did not resolve the problem, try cleaning the print cartridge. For more information, see
Clean the print cartridge contacts.

If the print cartridge status light continues to flash after cleaning the print cartridge,
replace the print cartridge. For more information, see Replace the print cartridges.

If this did not solve the issue, try the next solution.
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Solution 3: Print in ink-backup mode

Solution: If you do not have a replacement print cartridge, you can still print in ink
backup mode. Remove the problem cartridge and print with the remaining cartridge.

For more information, see:
Use ink-backup mode

Print quality troubleshooting

If you are having problems with print quality, try the solutions in this section and observe
the following guidelines.

To troubleshoot print quality issues

1. Check the print cartridges.
HP recommends that you use genuine HP print cartridges. Genuine HP print
cartridges are designed and tested with HP printers to help you easily produce great
results, time after time.

BY NOTE: HP cannot guarantee the quality or reliability of non-HP supplies. Printer
service or repairs required as a result of using a non-HP supply will not be covered
under warranty.

If you believe you purchased genuine HP ink cartridges, go to:
www.hp.com/go/anticounterfeit

For more information, see Replace the print cartridges.

2. Check the ink levels.
If you have installed a refilled or remanufactured print cartridge, or a cartridge that
has been used in another printer, the ink level indicator will be inaccurate or
unavailable. The ink levels provided are an estimate. When print cartridges are truly
low on ink, printouts will be faded or streaked. As long as print quality is acceptable,
there is no reason to replace print cartridges. Low ink warnings are provided for
planning purposes only.
For more information, see Check the estimated ink levels.
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3. Make sure you turn off the product by pressing the On button.

/\ CAUTION: Do not turn off the product by turning off a power strip or unplugging
the power cord from it. If you improperly turn off the product, the print carriage
does not return to the correct position and the print cartridges can dry out.

4. To achieve the best print quality, HP recommends using HP papers that are
specifically designed for the type of project you are printing along with genuine HP
ink. HP papers and HP ink are specifically designed to work well together to provide
high-quality output.

5. Check the product settings to make sure that the print mode and paper selection is
correct for the paper and the task.

For more information, see Set the paper type for printing and Choose papers for
printing and copying.

6. If the cartridges are genuine HP and the product is not in backup mode, print a self-
test report to determine if the product and ink supplies are operating correctly.

This will use one sheet of plain paper and a very small amount of ink.

For more information, see Print a self-test report.

7. Evaluate the self-test report.

If the self-test report shows a defect, try the following:

e Cleanthe print cartridges automatically. For more information, see Clean the print
cartridges.

» If you are missing lines when you print, clean the electrical contacts. For more
information, see Clean the print cartridge contacts.

* Replace the print cartridge. For more information, see Replace the print
cartridges.

For more information, see Print a self-test report.

8. If the self-test report does not show a problem, investigate other causes, such as the
image file or software program.
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For additional print cartridge troubleshooting, visit the HP Web site at www.hp.com/
support.

This section contains the following topics:

e Wrong, inaccurate, or bleeding colors

* Inkis not filling the text or graphics completely

» The printout has a horizontal band of distortion near the bottom of a borderless print
e Printouts have horizontal streaks or lines

»  Printouts are faded or have dull colors

e Printouts seem blurry or fuzzy

e Printouts have vertical streaks

e Printouts are slanted or skewed

» Ink streaks on the back of the paper

» Paper is not picked up from the input tray

» The text edges are jagged
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Wrong, inaccurate, or bleeding colors

If your printout has one of the following print quality problems, try the solutions in this
section for help.
« Colors look different than what you expected.

For example, the colors in your graphic or photo look one way on your computer
screen but print out differently, or magenta was replaced with cyan in your printout.

e Colors run into each other, or look like they are smeared on the page. The edges
might have a feathering appearance instead of being sharp and defined.
Try the following solutions if the colors appear wrong, inaccurate, or bleed into each other.

e Solution 1: HP recommends using genuine HP print cartridges
e Solution 2: Check the paper loaded in the input tray

e Solution 3: Check the paper type

e Solution 4: Check to see if the product is in ink-backup mode
e Solution 5: Check the print settings

e Solution 6: Clean the print cartridges
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Solution 1: HP recommends using genuine HP print cartridges
Solution: Check to see if your print cartridges are genuine HP print cartridges.

HP recommends that you use genuine HP print cartridges. Genuine HP print
cartridges are designed and tested with HP printers to help you easily produce great
results, time after time.

Bf NOTE: HP cannot guarantee the quality or reliability of non-HP supplies. Printer
service or repairs required as a result of using a non-HP supply will not be covered
under warranty.

If you believe you purchased genuine HP print cartridges, go to:
www.hp.com/go/anticounterfeit

Cause: Non-HP ink was being used.
If this did not solve the issue, try the next solution.

Solution 2: Check the paper loaded in the input tray

Solution: Make sure the paper is loaded correctly and that it is not wrinkled or too

thick.

» Load paper with the side you want to print on facing down. For example, if you
are loading glossy photo paper, load the paper with the glossy side down.

« If the paper is too close to the print cartridge during printing, the ink might be
smeared. This can happen if the paper is raised, wrinkled, or very thick, such as
a mailing envelope. Make sure the paper lays flat in the input tray and is not
wrinkled.
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For more information, see:

e Load paper
* Information on paper

Cause: The paper was loaded incorrectly, or it was wrinkled or too thick.
If this did not solve the issue, try the next solution.

Solution 3: Check the paper type

Solution: HP recommends that you use HP Advanced Papers or any other paper
type that is appropriate for the product.
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Always make sure the paper you are printing on is flat. For best results when printing
images, use HP Advanced Photo Paper.

Store photo media in its original packaging inside a resealable plastic bag on a flat
surface in a cool, dry place. When you are ready to print, remove only the paper you
plan to use immediately. When you have finished printing, return any unused photo
paper to the plastic bag. This will prevent the photo paper from curling.

B NOTE: There is no problem with the ink supplies and replacing the print
cartridges is unnecessary.

For more information, see:

« Recommended papers for printing and copying
* Information on paper

Cause: The wrong kind of paper was loaded in the input tray.
If this did not solve the issue, try the next solution.

Solution 4: Check to see if the product is in ink-backup mode

Solution: Check to see if the the product is printing in ink-backup mode, with only
one print cartridge installed.

If the product s in ink-backup mode, text and photo quality will differ from those printed
when using both print cartridges.

If you are satisfied with the print quality, continue printing in ink-backup mode. Or,
replace the missing print cartridge.

For more information, see:

¢ Use ink-backup mode
* Replace the print cartridges

Cause: A print cartridge was missing and the product was printing in ink-backup
mode.

If this did not solve the issue, try the next solution.
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Solution 5: Check the print settings

Solution: Check the print settings.

» Check the print settings to see if the color settings are incorrect.
For example, check to see if the document is set to print in grayscale. Or, check
to see if advanced color settings such as saturation, brightness, or color tone, are
set to modify the appearance of colors.

»  Check the print quality setting and make sure it matches the type of paper loaded
in the product.
You might need to choose a lower print quality setting, if colors are running into
each other. Or, choose a higher setting if you are printing a high-quality photo,
and then make sure photo paper such as HP Advanced Photo Paper, is loaded
in the input tray.
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% NOTE: Onsome computer screens, colors might appear differently than they do
when printed on paper. In this case, there is nothing wrong with the product, print
settings, or print cartridges. No further troubleshooting is required.

For more information, see:

* Change the print speed or quality
» Choose papers for printing and copying

Cause: The print settings were set incorrectly.
If this did not solve the issue, try the next solution.

Solution 6: Clean the print cartridges

Solution: Print a self-test report to determine if there is a problem with the print
cartridges. If the self-test report shows a problem, clean the print cartridges. If the
problem persists, you might need to replace the print cartridges.

For more information on print cartridges, see Print cartridge troubleshooting.

Cause: The print cartridges need to be cleaned.

Ink is not filling the text or graphics completely

Try the following solutions if the ink is not filling the text or image completely so that it
appears that parts are missing or blank.

e Solution 1: HP recommends using genuine HP print cartridges

e Solution 2: Check the print settings

e Solution 3: Check the paper type

e Solution 4: Clean the print cartridges

Solution 1: HP recommends using genuine HP print cartridges
Solution: Check to see if your print cartridges are genuine HP print cartridges.

HP recommends that you use genuine HP print cartridges. Genuine HP print
cartridges are designed and tested with HP printers to help you easily produce great
results, time after time.
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Bf NOTE: HP cannot guarantee the quality or reliability of non-HP supplies. Printer
service or repairs required as a result of using a non-HP supply will not be covered
under warranty.

If you believe you purchased genuine HP print cartridges, go to:
www.hp.com/go/anticounterfeit

Cause: Non-HP ink was being used.
If this did not solve the issue, try the next solution.
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Solution 2: Check the print settings

Solution: Check the print settings.

« Check the paper type setting to make sure it matches the type of paper loaded in
the input tray.

« Check the quality setting. Use a higher quality setting to increase the amount of
ink used for printing.

For more information, see:

e Set the paper type for printing

* Change the print speed or quality

¢ Print using Maximum dpi

e Make a Fast copy

Cause: The paper type or print quality settings were incorrectly.

If this did not solve the issue, try the next solution.

Solution 3: Check the paper type

Solution: HP recommends that you use HP Advanced Papers or any other paper
type that is appropriate for the product.

Always make sure the paper you are printing on is flat. For best results when printing
images, use HP Advanced Photo Paper.

Store photo media in its original packaging inside a resealable plastic bag on a flat
surface in a cool, dry place. When you are ready to print, remove only the paper you
plan to use immediately. When you have finished printing, return any unused photo
paper to the plastic bag. This will prevent the photo paper from curling.

Bf NOTE: There is no problem with the ink supplies and replacing the print
cartridges is unnecessary.

For more information, see:

¢ Recommended papers for printing and copying
¢ Information on paper

Cause: The wrong kind of paper was loaded in the input tray.
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If this did not solve the issue, try the next solution.

Solution 4: Clean the print cartridges

Solution: Print a self-test report to determine if there is a problem with the print
cartridges. If the self-test report shows a problem, clean the print cartridges. If the
problem persists, you might need to replace the print cartridges.

For more information on print cartridges, see Print cartridge troubleshooting.

Cause: The print cartridges need to be cleaned.
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The printout has a horizontal band of distortion near the bottom of a borderless
print

Try the following solutions if your borderless print has a blurry band or line on the bottom
of it.

Bf NOTE: There is no problem with the ink supplies and replacing the print cartridges
iS unnecessary.

¢ Solution 1: Check the paper type
e Solution 2: Check the print quality setting
¢ Solution 3: Rotate the image

Solution 1: Check the paper type

Solution: HP recommends that you use HP Advanced Papers or any other paper
type that is appropriate for the product.

Always make sure the paper you are printing on is flat. For best results when printing
images, use HP Advanced Photo Paper.

Store photo media in its original packaging inside a resealable plastic bag on a flat
surface in a cool, dry place. When you are ready to print, remove only the paper you
plan to use immediately. When you have finished printing, return any unused photo
paper to the plastic bag. This will prevent the photo paper from curling.

BY NOTE: There is no problem with the ink supplies and replacing the print
cartridges is unnecessary.

For more information, see:

« Recommended papers for printing and copying
* Information on paper

Cause: The wrong kind of paper was loaded in the input tray.
If this did not solve the issue, try the next solution.
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Solution 2: Check the print quality setting

Solution: Check the quality setting. Use a higher quality setting to increase the
amount of ink used for printing.

B NOTE: For maximum dpi resolution, go to the Advanced tab, and then select
Enabled from the Maximum dpi drop-down list. For more information, see Print
using Maximum dpi.

For more information, see:

e Change the print speed or quality

e Print using Maximum dpi

e Make a Fast copy

Cause: The print quality setting was set too low.
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If this did not solve the issue, try the next solution.

Solution 3: Rotate the image

Solution: If the problem persists, use the software you installed with the product or
another software application to rotate your image 180 degrees so that the light blue,
gray, or brown hues in your image do not print at the bottom of the page.

For more information, see:

Change the page orientation

Cause: The photo image had light blue, gray, or brown hues that print near the
bottom of the page.

Printouts have horizontal streaks or lines

Try the following solutions if your printout has lines, streaks, or marks on it that run side-
to-side across the width of the page.

Solution 1: Make sure the paper is loaded correctly

Solution 2: Check the print quality setting

Solution 3: If the print cartridge was dropped, wait for it to recover

Solution 4: Clean the print cartridge nozzles

Solution 5: Clean the print cartridges

Solution 1: Make sure the paper is loaded correctly

Solution: Make sure the paper is loaded correctly.
For more information, see:

Load full-size paper

Cause: The paper was not feeding properly or was not loaded correctly.
If this did not solve the issue, try the next solution.
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Solution 2: Check the print quality setting

Solution: Check the quality setting. Use a higher quality setting to increase the
amount of ink used for printing.

Bf NOTE: For maximum dpi resolution, go to the Advanced tab, and then select
Enabled from the Maximum dpi drop-down list. For more information, see Print
using Maximum dpi.

For more information, see:

* Change the print speed or quality

e Print using Maximum dpi

* Make a Fast copy

Cause: The print quality setting was set to low.
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If this did not solve the issue, try the next solution.

Solution 3: If the print cartridge was dropped, wait for it to recover
Solution: Allow 30 minutes for the print cartridge to recover.

Cause: A tri-color or photo print cartridge was jarred or handled roughly during
installation.

If this did not solve the issue, try the next solution.

Solution 4: Clean the print cartridge nozzles

Solution: Check the print cartridges. If it looks as though there are fibers or dust
around the ink nozzles, clean the ink nozzle area of the print cartridge.

For more information, see:

Clean the area around the ink nozzles

Cause: The print cartridge nozzles needed to be cleaned.
If this did not solve the issue, try the next solution.

Solution 5: Clean the print cartridges

Solution: Check the estimated ink levels remaining in the print cartridges.

BY NOTE: Ink level warnings and indicators provide estimates for planning
purposes only. When you receive a low-ink warning message, consider having a
replacement cartridge available to avoid possible printing delays. You do not need
to replace the print cartridges until print quality becomes unacceptable.

If there is ink remaining in the print cartridges, but you are still noticing a problem,
print a self-test report to determine if there is a problem with the print cartridges. If the
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self-test report shows a problem, clean the print cartridges. If the problem persists,
you might need to replace the print cartridges.

For more information, see:
e Print cartridge troubleshooting
e Print a self-test report

Cause: The print cartridges needed to be cleaned or there was insufficient ink.

Printouts are faded or have dull colors

Try the following solutions if the colors in your printout are not as bright and intense as
you expected.
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e Solution 1: Check the print settings

e Solution 2: Check the paper type

* Solution 3: If you are making a copy, place a protective sheet on the glass
e Solution 4: Clean the glass

» Solution 5: Clean the print cartridges

Solution 1: Check the print settings

Solution: Check the print settings.

« Check the paper type setting to make sure it matches the type of paper loaded in
the input tray.

»  Check the quality setting. Use a higher quality setting to increase the amount of
ink used for printing.

For more information, see:

e Set the paper type for printing

e Change the print speed or quality

e Print using Maximum dpi

e Make a Fast copy

Cause: The paper type or print quality settings were incorrectly.

If this did not solve the issue, try the next solution.

Solution 2: Check the paper type

Solution: HP recommends that you use HP Advanced Papers or any other paper
type that is appropriate for the product.

Always make sure the paper you are printing on is flat. For best results when printing
images, use HP Advanced Photo Paper.

Store photo media in its original packaging inside a resealable plastic bag on a flat
surface in a cool, dry place. When you are ready to print, remove only the paper you
plan to use immediately. When you have finished printing, return any unused photo
paper to the plastic bag. This will prevent the photo paper from curling.

Print quality troubleshooting 109



Chapter 12

Bf NOTE: There is no problem with the ink supplies and replacing the print
cartridges is unnecessary.

For more information, see:

« Recommended papers for printing and copying
e Information on paper

Cause: The wrong kind of paper was loaded in the input tray.
If this did not solve the issue, try the next solution.
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Solution 3: If you are making a copy, place a protective sheet on the glass

Solution: If you are making a copy, try placing one or more clear plastic sheet
protectors directly on the glass, and then place the original print side down on top of
the sheet protectors.

Cause: The quality of the original was poor.
If this did not solve the issue, try the next solution.

Solution 4: Clean the glass
Solution: Clean the glass and lid backing.
For more information, see:
» Clean the lid backing

» Clean the glass

Cause: Debris might be stuck on the glass or on the back of the document lid; this
causes poor copy quality and slows down processing.

If this did not solve the issue, try the next solution.

Solution 5: Clean the print cartridges
Solution: Check the estimated ink levels remaining in the print cartridges.

BY NOTE: Ink level warnings and indicators provide estimates for planning
purposes only. When you receive a low-ink warning message, consider having a
replacement cartridge available to avoid possible printing delays. You do not need
to replace the print cartridges until print quality becomes unacceptable.

If there is ink remaining in the print cartridges, but you are still noticing a problem,
print a self-test report to determine if there is a problem with the print cartridges. If the
self-test report shows a problem, clean the print cartridges. If the problem persists,
you might need to replace the print cartridges.

For more information, see:
e Print cartridge troubleshooting
e Print a self-test report
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Cause: The print cartridges needed to be cleaned or there was insufficient ink.

Printouts seem blurry or fuzzy
Try the following solutions if your printout is smudged or unclear.

BY NOTE: There is no problem with the ink supplies and replacing the print cartridges
is unnecessary.

- TIP: After reviewing the solutions in this section, you can go to HP's support Web
site to see if there is additional troubleshooting help. For more information, go to:
www.hp.com/support.
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e Solution 1: Check the print settings
* Solution 2: Check the resolution of the image

Solution 1: Check the print settings

Solution: Check the print settings.

«  Check the paper type setting to make sure it matches the type of paper loaded in
the input tray.

« Check the quality setting. Use a higher quality setting to increase the amount of
ink used for printing.

For more information, see:

¢ Set the paper type for printing

e Change the print speed or quality
e Print using Maximum dpi

e Make a Fast copy
Cause: The paper type or print quality settings were incorrectly.

If this did not solve the issue, try the next solution.

Solution 2: Check the resolution of the image

Solution: Check the resolution of the image. If you are printing a photo or graphic,
and the resolution is too low, it will be blurry or fuzzy when printed.

If a digital photo or rasterized graphic has been resized, it can be blurry or fuzzy when
printed.

Cause: The resolution of the image was low.

Printouts have vertical streaks

Refer to this section if your printout has a lines, streaks, or marks on it that run up-
and-down or lengthwise down the page.

Bf NOTE: There is no problem with the ink supplies and replacing the print
cartridges is unnecessary.
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Solution: HP recommends that you use HP Advanced Papers or any other paper
type that is appropriate for the product.

Always make sure the paper you are printing on is flat. For best results when printing
images, use HP Advanced Photo Paper.

Store photo media in its original packaging inside a resealable plastic bag on a flat
surface in a cool, dry place. When you are ready to print, remove only the paper you
plan to use immediately. When you have finished printing, return any unused photo
paper to the plastic bag. This will prevent the photo paper from curling.

Bf NOTE: There is no problem with the ink supplies and replacing the print
cartridges is unnecessary.

—
=
o
=
o
(]
n
>
o
o
=
>
«Q

For more information, see:

» Recommended papers for printing and copying
¢ Information on paper

Cause: The wrong kind of paper was loaded in the input tray.

Printouts are slanted or skewed
Try the following solutions if your printout does not appear straight on the page.

e Solution 1: Make sure the paper is loaded correctly
e Solution 2: Make sure only one type of paper is loaded
¢ Solution 3: Check the rear access door

Solution 1: Make sure the paper is loaded correctly
Solution: Make sure the paper is loaded correctly.
For more information, see:

Load full-size paper

Cause: The paper was not feeding properly or was not loaded correctly.
If this did not solve the issue, try the next solution.

Solution 2: Make sure only one type of paper is loaded
Solution: Load only one type of paper at a time.
Cause: More than one type of paper was loaded in the input tray.
If this did not solve the issue, try the next solution.

Solution 3: Check the rear access door
Solution: Make sure the rear access door is securely installed.
Cause: The rear access door was not securely installed.
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Ink streaks on the back of the paper
Try the following solutions if there is smeared ink on the back of your printout.

e Solution 1: Print on a page of plain paper

e Solution 2: Wait while the ink dries

Solution 1: Print on a page of plain paper

Solution: Print one or several pages of plain paper to soak up any excess ink in
the product.

To remove excess ink using plain paper

1. Load several sheets of plain paper in the input tray.

2.
3.
4

Cause:
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Wait five minutes.
Print a document with little or no text.

Check the back of the paper for ink. If there is still ink on the back of the paper,
try printing on another page of plain paper.

Ink accumulated inside the product, where the back of the paper rests

during printing.

If this did not solve the issue, try the next solution.

Solution 2: Wait while the ink dries

Solution: Wait at least thirty minutes for the ink inside the product to dry, then try
the print job again.

Cause:

The excess ink in the product needed to dry out.

Paper is not picked up from the input tray

Solution:

Do one of the following:

If the product is out of paper or there are only a few sheets remaining, load more
paper in the input tray.
If there is paper in the input tray:

Remove the stack of paper from the input tray and verify that all the paper in
the input tray is the same size and type.
Replace any paper that is ripped, dusty, wrinkled, or bent.

If the paper is curled, uncurl the paper by gently bending it in the opposite
direction of the curl or replace the paper.

Tap the stack of paper on a flat surface to align the edges.
Verify that the stack of paper contains between 10 and 25 sheets of paper.
Reload the paper into the input tray.

Follow the prompts on the display to continue.
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Cause: There was not enough paper in the input tray.

The text edges are jagged

Try the following solutions if the text in your printouts is not sharp and the edges are
rough.

Bf NOTE: There is no problem with the ink supplies and replacing the print
cartridges is unnecessary.

Solution: Use TrueType or OpenType fonts to ensure that the product is able to
print smooth fonts. When selecting a font, look for the TrueType or OpenType icon.
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Some software applications offer custom fonts that have jagged edges when enlarged
or printed. Also, if you want to print bitmapped text, it might have jagged edges when
enlarged or printed.

Cause: The font was a custom size.

Print troubleshooting

Use this section to solve these printing problems:

e Envelopes print incorrectly

e Borderless printing produces unexpected results

e The product is not responding

e The product prints meaningless characters

¢ Nothing happens when | try to print

e The pages in my document came out in the wrong order

e The margins are not printing as expected

e Text or graphics are cut off at the edge of the page

* A blank page came out while printing

e Inkis spraying the inside of the HP All-in-One when | print a photo

Envelopes print incorrectly

Try the following solutions to resolve the issue. Solutions are listed in order, with the most
likely solution first. If the first solution does not solve the problem, continue trying the
remaining solutions until the issue is resolved.

e Solution 1: Reload the envelopes in the input tray

e Solution 2: Load a different type of envelope

Solution 1: Reload the envelopes in the input tray

Solution: Remove all paper from the input tray. Load a stack of envelopes in the
input tray, with the envelope flaps facing up and on the left.

BY NOTE: To avoid paper jams, tuck the flaps inside the envelopes.
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Cause: A stack of envelopes was loaded incorrectly.
If this did not solve the issue, try the next solution.
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Solution 2: Load a different type of envelope

Solution: Do not use shiny or embossed envelopes or envelopes that have clasps
or windows.

Cause: The wrong type of envelope was loaded.

Borderless printing produces unexpected results

Try the following solutions to resolve the issue. Solutions are listed in order, with the most
likely solution first. If the first solution does not solve the problem, continue trying the
remaining solutions until the issue is resolved.

e Solution 1: Print from the HP Photosmart Software

e Solution 2: Use the appropriate media

Solution 1: Print from the HP Photosmart Software

Solution: Try printing the image from the photo imaging software that came with
the product.

Cause: Printing a borderless image from a non-HP software application produced
unexpected results.

If this did not solve the issue, try the next solution.

Solution 2: Use the appropriate media

Solution: To print a borderless image, use 10 x 15 cm (4 x 6 inch) HP Advanced
Photo Papers.

For more information, see:
Print a borderless image

Cause: Use of inappropriate media.
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The product is not responding

Try the following solutions to resolve the issue. Solutions are listed in order, with the most
likely solution first. If the first solution does not solve the problem, continue trying the
remaining solutions until the issue is resolved.

e Solution 1: Wait for the product to finish other tasks

e Solution 2: Check for a paper jam

e Solution 3: Load more paper in the input tray

e Solution 4: Check for a print carriage stall

e Solution 5: Check the cable connections to the product

e Solution 6: Make sure that the product is turned on

e Solution 7: Restart the product

e Solution 8: Check the print driver status

e Solution 9: Check the print gueue for canceled jobs
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Solution 1: Wait for the product to finish other tasks

Solution: If the product is performing another task such as copying or scanning,
your print job will be delayed until the product completes the current task.

Some documents take a long time to print. If nothing has printed several minutes after
you sent a print job to the product, check your computer to see if there are any
messages.

Cause: The product was busy with another task.
If this did not solve the issue, try the next solution.

Solution 2: Check for a paper jam
Solution: Clear the paper jam.
For more information, see:
Clear paper jams
Cause: The<ns1:XMLFault xmlns:ns1="http://cxf.apache.org/bindings/xformat"><ns1:faultstring xmlns:ns1="http://cxf.apache.org/bindings/xformat">java.lang.OutOfMemoryError: Java heap space</ns1:faultstring></ns1:XMLFault>